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1 Welcome

LEAD is a learning event authoring suite for learning analysts, instructional designers, and

curriculum developers. It is a mature and comprehensive solution from training needs analysis

through content and assessment design and development. LEAD provides links from:

· Performance requirements, to task analysis, to learning objectives, to assessments, and to

content.

· Resources to learning events, and to specific pieces of content.

Links make it easy for you to manage and make updates to learning events.

1.1 Login to LEAD

Use the User ID you were provided (usually first name.last name) and the password you

created when you requested the account to login to LEAD.

· Use the Forgot Password?  link to receive a temporary password, if you have forgotten

your password. If you managed to lock yourself out, your LEAD manager will get an

automatic email notification, so they can unlock your account. 

1.1.1   Request an Account

The easiest way to get an account to use LEAD is to select Request an Account on the login

screen for your organization's instance of LEAD. Fill out your information on the screen and

select Submit. LEAD notifies the LEAD manager of your request automatically. 

1.1.2   Forgot Password

If, at any point you forget your password, select the Forgot Password? link on the Login screen

and complete the fields below. An automatic email to the LEAD manager will start the process

of having your password reset. If the information you supplied matches an existing account,

you will receive an email with a temporary password automatically. Otherwise, you'll have to

wait for a manager to review your request and send you a temporary password. Alternatively,

you can ask a LEAD manager to reset your password.

1.2 Using LEAD

Some general notes on how to use LEAD:

10
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· Any time you want to get back to the Dashboard, click on LEAD in the top left of the header

bar (the orange bar).

· If you need more room for your content, you can minimize the left-hand menu by clicking

on the three-bar icon (hamburger icon) next to LEAD in the header bar. Selecting the three-

bar icon again will maximize the menu again.

· To view any system announcements, select the Announcement icon that displays between

your user name and the help icon in the header bar. Once you've reviewed the

announcements, you can close the pop-up. There are three types of Announcement icons:

o  - there is a new announcement to read.

o  - there are previously read announcements that are still active.

o  - there is a problem with the license for LEAD.

· The area of the screen that displays a tree structure can also be enlarged by clicking and

dragging the bottom right corner of the tree structure window (or frame). You will find re-

sizable tree structures on the following screens:

o  Initiatives > Analysis

o  Initiatives > Design

o  Initiatives > Develop

o Competencies > O*Net

1.3 Help

When you select the Help icon on the top right of the screen, you get a drop-down menu.

Choose:

· Help to open help for the current screen in a new tab of your browser.

· Overview or User's Manual to open the PDF.

· Contact Us  to provide us with your feedback comments, questions, or requests. If you

are logged in, the form will pre-fill your contact information from your user profile.

· About to review information about LEAD, including the version of LEAD. Select X at the

top right of the pop-up to close the pop-up.

· License Agreement to review the license information. Select X at the top right of the pop-

up to close the pop-up.

12
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To review help for a pop-up, select Help next to the X on a pop-up window. This will open

help for the current pop-up in a new tab of your browser.

1.3.1   Contact US

When you select the Contact Us option under the Help drop-down menu, you get a pop-up

screen to provide us with your feedback comments, questions, or requests. If you are logged

in to LEAD, the form will pre-fill your contact information from your user profile.

1.4 Your User Name

When you select your user name in the top right of the screen, you can select:

· My Profile  to view and edit your account information and preferences.

· Change Password  to change your password.

· Log Out to close your session in LEAD. Remember to close your browser, too.

1.4.1   My Profile

On the My Profile Detail screen, you can review or edit your account information and

preferences. Only a LEAD manager can edit fields marked "(not user editable)".

1.4.2   Change Password

On the Change Password screen, you can change your existing password to a new password

to use when you login to LEAD.

12
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Dashboard

This chapter describes the dashboard that you can use to access your initiatives,
milestones, and assignments in one place.
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2 Dashboard

On the Dashboard screen, you can view your initiatives, any assigned milestones that are not

in completed status, and a list of your assignments. 

· Selecting any Initiative will open that initiative in the Initiatives > Analysis screen. 

· Selecting a Milestone will open that milestone in the Home > Milestones screen. 

· Selecting an Assignment will open that assignment in the Home > Assignments screen.

2.1 Milestones

The Milestones screen lists your milestones, grouped by initiative. Unlike the Dashboard, this

screen will show all milestones of your initiatives, regardless of Status, for all of your initiatives

(a specific initiative is 'yours' when you are the owner or creator of the initiative, or when

someone has added you as a team member to any initiative.) that have been assigned to

you. 

You can also create Self-Assigned Milestones, by selecting +New. 

From this screen you can select a milestone and then use the icons in each row in the Actions

and Delete columns to:

· View the detailed information of the milestone.

· Edit the milestone information.

· Select Show History  to review the changes made to the milestone, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Delete a self-assigned milestone - delete initiative-based milestones on the Initiatives >

Analysis > Training Needs Analysis > Milestones screen (if the TNA is not approved).

2.2 Assignments

The Assignments screen lists your assignments, grouped by initiative. Unlike the Dashboard,

this screen will show all your assignments (by initiatives, if related to any initiative), regardless

of Status. 

You can also create self-assigned assignments, by selecting +New. 

From this screen you can select an assignment and then use the icons in each row in the

Actions and Delete columns to:

100
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· View the detailed information of the assignment.

· Edit the assignment information.

· Select Show History  to review the changes made to the assignment, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Delete a self-assigned assignment - delete initiative-based assignments on the Initiatives

> Analysis/Design > Initiative Management > Assignments screen.

100
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Initiatives

This chapter is all about initiatives (or learning events), how to analyze, design, develop
and implement them.
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3 Initiatives

Initiatives are the main reason for using LEAD. An initiative is a learning event, like a course or

workshop, which is created to close an identified performance gap. LEAD supports the

development of several types of learning events (see Scope below). LEAD uses the ADDIE

(Analysis, Design, Develop, Implement, and Evaluate) instructional design process to develop

and maintain initiatives. The main tabs under Initiatives mirror that process.

Unlike the Dashboard, this screen will show all the initiatives in LEAD, depending on your Filter

selection, of course. When you select any initiative on this screen you can select one of the

subtabs under the Initiatives tree on the left to open that initiative in that subtab, or you can

use one of the icons above the list to:

· Create a New  initiative.

· Change the State  of the initiative. 

· Search for an initiative.

· Select Explain Flag  to review the reasons the initiative has been flagged.

· Lock the initiative to prevent any user from making changes without first unlocking the

initiative.

Or you can use the icons in the Actions column to:

· View the detailed information of the initiative.

· Edit  the initiative information.

· Select Show History  to review the changes made to the initiative information, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

You can click on the column headers of each table to sort the entries by that column. Clicking

on a column header again, will reverse the sort. Small arrows in the column header let you

know which way the data is currently sorted.

3.1 Analysis

On the Analysis tab, you can manage your initiative, complete the Training Needs Analysis

and the Task Analysis. You can also generate the analysis documents under the Documents

folder. 

Use the tree structure to expand out the four main folders and get to the data you need to

work with. To make more room to see items in the tree structure, click and drag the bottom

right corner of the tree window (or frame). If you need even more space, click on the three-

18

18

110

19

100



19

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2022 Aimereon

Initiatives

bar icon (hamburger icon) next to LEAD in the header bar to minimize the main menu to show

only the icons. To see all of the menu items again, click on the hamburger icon again. 

3.1.1   Initiative Management

When you click on the Initiative Management folder, you can edit information about the

initiative, and when you expand the folder, you can manage the Team Members, Assignments,

and Resources for the initiative. You can access this folder from both the Initiatives > Analysis

and the Initiatives > Design screens.

3.1.1.1   Team Members

The Team Members screen lists the users currently assigned to the initiative. You can access

this folder from both the Initiatives > Analysis > Initiative Management and the Initiatives >

Design > Initiative Management screens. 

3.1.1.2   Assignments

The Assignments screen lists all the assignments that have been created for the initiative. You

can access this screen from both the Initiatives > Analysis > Initiative Management and the

Initiatives > Design > Initiative Management screens. On this screen you can:

· Create a New assignment.

· Select an assignment and:

o View the detailed information of the assignment.

o Edit the assignment information.

o Select Show History  to review the changes made to the assignment, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete an assignment.

3.1.1.3   Resource Management

On the Resource Management screen, you can review, view, and update any resources that

are cited anywhere in the initiative. This includes resources cited in the:

· TNA or TMD Resources screen under the Training Data folder, or for a specific Initiative

Location.

· Task Analysis for a Task, Subtask, or Step.

· And on the Develop tab:

o Sub-Elements: Page / Paragraph / Caution / Note / Warning.

100
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o Sheets.

o Certain Test Items.

o Storyboard.

o Test Instructions.

On this screen:

· Use the Type drop-down to limit the list of resources to a specific sub-category, as set up

on Customization  screens. 

· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. 

· Select the Show Out-of-Date Resources Separately check box to see those outdated

resources at the top of the list grouped under: Items to Update. 

· Export a spreadsheet listing all cited resources.

· View the different versions of a resource by clicking on the arrow in the first column.

· Select a resource and then: 

o Generate a Related Materials Report that lists every place within the initiative where the

selected resource is cited or used.

o Generate an Impact Report that lists every place within the initiative where any previous

version of the selected resource is cited or used.

o Update  to the latest version of a resource.

o View the resource information.

o Edit the resource information if the resource is not approved.

Note: This will update the resource everywhere it is used in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.

3.1.2   Training Needs Analysis

The Training Needs Analysis (TNA) is the first step in any initiative, which seeks to determine

whether a learning event is the right answer to close a performance gap on the job. That is,

do you have new equipment that you need to train people on, or is there a gap between the

performance standard and the actual performance you need to close, or do you need to

develop a learning event for another reason?

113
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When you click on the TNA folder, you can edit information about the Training Needs

Analysis and initiative, and when you expand the folder, you can capture the information

required for the TNA in the folders/fields under the TNA, this includes information about the

reasons for the TNA under Justification, as well as information about the initiative, the Target

Audience, and some overall training data. The TNA shares some information with the Training

Management Document (as shown in the title for each area in this document) until the TNA is

approved.

3.1.2.1   Justification (TNA Only)

On the Justification screen, you can capture the reasons for the development of a learning

event in the following fields:

· Reference(s)

· Cost / Benefit Analysis

· Changes from Previous Version

· Impact If Not Approved

You can:

· View the information. 

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.2   Initiative Overview (TNA and TMD)
On the Initiative Overview screen, you can enter a description, or overview, of the proposed

learning event that will close the performance gap.

You can:

· View the information by clicking on the Initiative Overview folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.3   Milestones (TNA Only)

The Milestone screen lists of the milestones for this initiative. You can add milestones by

selecting +New. From this screen you can select a milestone and then use the icons in each

row in the Actions and Delete columns to:

· View the detailed information of the milestone.

· Edit the milestone information.

101
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· Select Show History  to review the changes made to the milestone, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Delete the milestone.

3.1.2.4   Safety Risks and Hazardous Materials (TNA Only)
On the Safety Risks and Hazardous Materials screen, you can document any safety risks and

hazardous materials that might be met or used during the delivery of the learning event.

You can:

· View the information by clicking on the Safety Risks and Hazardous Materials folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.5   Target Audience (TNA and TMD)
On the Target Audience screen, you can describe who the learning event is for and how many

people are in the target audience.

You can:

· View the information by clicking on the Target Audience folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.6   Qualification Earned (TNA and TMD)
On the Qualification Earned screen, you can list any qualification(s) or certification(s) that a

participant earns by completing the learning event.

You can:

· View the information by clicking on the Qualification Earned folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.7   Associated Learning Events (TNA and TMD)
On the Associated Learning Events screen, you can list any associated learning events to the

current initiative, including:

· Prerequisite learning events that participants must or should complete before they can

100
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attend this learning event or initiative.

· Equivalent learning events that participants can complete instead of this learning event or

initiative.

· Follow-on learning events that participants can or should complete after they completed

this learning event or initiative.

You can:

· View the information by clicking on the Associated Learning Events folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.8   Training Data (TNA and TMD)

The Training Data screen lists the current and planned data for the learning event, including

expected length, number of hours, minimum and maximum capacities, number of convenings

(how often the learning event will be delivered), and the expected throughput of participants.

You can view the information by clicking on Training Data in the tree structure, once there

you can:

· Edit the training data. 

· Select Show History  to review the changes made to the training data, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

In the screens underneath the Training Data screen, you can enter information about the:

· Schedule for delivering the learning event (in the TMD only).

· Facilities needed to deliver the learning event.

· Funding needed to develop and/or deliver the learning event.

· Personnel needed to deliver the learning event.

· Resources needed to deliver the learning event.

3.1.2.8.1   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. On this screen you can:

· View the facility information by selecting Facilities under the Training Data folder.
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· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.8.2   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Training Data >

Funding screen, so if you changed the year by mistake you can return to the previous

selected year without a loss of data. The fiscal year used in LEAD is whatever fiscal year your

organization uses. On the Funding screen you can:

· View the funding information by selecting Funding under the Training Data folder.

· Edit the information.

· Add New funding or expense rows in the table.

· Delete funding or expense rows in the table.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.8.3   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. In LEAD, you can list the personnel requirements

for four types of personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.

On this screen you can:

· View the personnel information by selecting Personnel under the Training Data folder.

100

100



25

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2022 Aimereon

Initiatives

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.8.4   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during development.

On this screen you can:

· View the selected resource list by selecting Resources under the Training Data folder.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Select a resource and then: 

o Generate a Related Materials Report that lists every place within the initiative where the

selected resource is cited or used.

o Update  to the latest version of a resource.

o View a selected resource.

· Edit the resource list:

o On Hand and Required quantities.

Note: If a resource is missing in the output of the TNA or TMD, but is listed on the

screen, check the Required quantity. If the Required quantity is set to 0, it will not output

in the TNA or TMD. 

o Delete a selected resource from the list (provided it is not selected or cited on the

Develop tab).

o Select resources  for the list.

3.1.2.9   Initiative Locations (TNA and TMD)

On the Initiative Locations screen, you can select the initiative locations where training will

take place. All data from the Training Data screen and sub-folders will be copied to a newly

selected initiative location. You can add a New initiative location to the TNA or TMD from this

screen. Initiative Locations are created on the Admin > Locations  screen.

Once you selected the initiative location, you can:

· View the initiative location's information, including the current and planned data for the

learning event, including expected length, number of hours, minimum and maximum
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capacities, number of convenings (how often the learning event will be delivered), and

the expected throughput of participants.

· Edit the initiative location's information.

· Select Show History  to review the changes made to the initiative location, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Delete the selected initiative location from the initiative.

In the screens underneath the selected initiative location, you can enter information about

the:

· Schedule for delivering the learning event (in the TMD only).

· Facilities needed to deliver the learning event at that initiative location.

· Funding needed to deliver the learning event at that initiative location.

· Personnel needed to deliver the learning event at that initiative location.

· Resources needed to deliver the learning event at that initiative location.

3.1.2.9.1   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. When you first add a new Initiative Location, the data is copied from the Training Data

> Facilities screen for you to edit for the specific Initiative Location. On this screen you can:

· View the facility information by selecting Facilities under the [Selected Initiative Location]

> Initiative Locations folder.

· Edit the information copied from the Training Data > Facilities screen.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.9.2   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Initiative Locations >

[Selected Initiative Location] >Funding screen, so if you changed the year by mistake you can

return to the previous selected year without a loss of data. The fiscal year used in LEAD is

whatever fiscal year your organization uses. When you first add a new Initiative Location, the
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data is copied from the Training Data > Funding screen for you to edit for the specific

Initiative Location. On the Funding screen you can:

· View the funding information by selecting Funding under the selected Initiative Location.

· Edit the information copied from the Training Data > Funding screen.

· Add New funding or expense rows in the table.

· Delete funding or expense rows in the table.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.9.3   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. When you first add a new Initiative Location, the

data is copied from the Training Data > Personnel screen for you to edit for the specific

Initiative Location. In LEAD, you can list the personnel requirements for four types of

personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.

On this screen you can:

· View the personnel information by selecting Personnel under the selected Initiative

Location.

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.1.2.9.4   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate
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needing and LEAD will add to this list of resources when you select them during development.

When you first add a new Initiative Location, the data is copied from the Training Data >

Resources screen for you to edit for the specific Initiative Location. On this screen you can:

· View the selected resource list by selecting Resources under the selected Initiative

Location. 

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Select a resource and then: 

o Generate a Related Materials Report that lists every place within the initiative where the

selected resource is cited or used.

o View a selected resource. 

· Edit the resource list:

o On Hand and Required quantities

Note: If a resource is missing in the output of the TNA or TMD, but is listed on the

screen, check the Required quantity. If the Required quantity is set to 0, it will not output

in the TNA or TMD. 

o Select resources  for the list.

o Delete a selected resource from the list (provided it is not selected or cited on the

Develop tab and it was added only for this Initiative Location).

3.1.3   Task Analysis

The Task Analysis area captures the job, task analysis information of the tasks that will be

trained to during the learning event. The skill hierarchy available to capture this information

includes: 

· Job - based on the selected competency data; one or more jobs will be created when you

first select from the competencies to include in the task analysis.

o Duty - is a grouping of tasks. One duty is automatically created for every job. You can

add duties to help you manage the tasks.

§ Task - is a specific work behavior, with a clear beginning and end point, which can be

observed and measured. One task is created for each competency task, knowledge,

skill, or ability that is selected. You can have multiple tasks created from the same

competency selection. You can break down a task into two or more subtasks, if

needed.

· Subtask - is a major part of a tasks. You can break down a subtask into two or more

steps, if needed.
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o Step - is a major part of a subtask. A step is the most specific form of behavior

and the smallest part defined in the task analysis.

The skill hierarchy you develop in the task analysis is approved once the initiative is approved.

This allows you to make changes as needed, while you progress with your initiative. You have

the following actions available to you:

· View the information by clicking on the Task Analysis folder.

· Add New jobs not linked to competencies. 

· Resequence  the jobs below the Task Analysis folder in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the skill hierarchy.

· Delete a selected job.

· Select Explain Flag  to review the reasons the Task Analysis has been flagged.

· Use Create From Competencies to select competencies and create the first draft of the

skill hierarchy. You can continue to build your skill hierarchy from competencies

throughout your analysis.

3.1.3.1   Job
LEAD creates one or more jobs automatically based on the selected competencies. You can

rename the job title and add a job description, if desired. To add jobs manually, go to the

Task Analysis folder. On the Job screen you can:

· View the information by clicking on the Job folder.

· Edit the information.

· Add New duties.

· Resequence  the duties below the job folder in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the skill hierarchy.

· Delete the selected job (including all duties, tasks, subtasks, and steps under the job).

· Select Explain Flag  to review the reasons the job has been flagged.

· Use Create From Competencies to select competencies from the selected job (see the

"This item was created from Competencies" for the currently selected job) to add to your

skill hierarchy.
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3.1.3.2   Duty
LEAD creates a new duty automatically when you first select from the competencies data.

Duties allow you to group tasks. You can rename the automatically created duty to give it a

more user-friendly name and you can add additional duties (from the Job folder) as needed.

On the Duty screen you can:

· View the information by clicking on the Duty folder.

· Edit the information.

· Resequence  the tasks below the Duty folder in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the skill hierarchy.

· Delete the selected duty (including all tasks, subtasks, and steps under the duty).

· Select Explain Flag  to review the reasons the duty has been flagged.

· Use Create From Competencies to select competencies to add to your skill hierarchy.

3.1.3.3   Task
LEAD creates tasks automatically when you first select tasks, knowledge, skills, or abilities from

the competencies data. A task is a specific work behavior, with a clear beginning and end

point, that can be observed and measured. You can have multiple tasks based on the same

competency selection. You can break down a task into two or more subtasks, as needed. You

can (and should) edit the task as needed. The Task screen has multiple tabs that you can

minimize to see just the information you are working on:

· Task  - for the main information about the task.

· Task Attributes  - to list the conditions and standards under which the task is performed

on the job, along with any resources that someone would have available when they do

the task on the job. Conditions  and Standards  can be added to the Library in LEAD,

while Resources  are listed in their respective categories on the Resources tab.

· Training Task Analysis - a list of different areas with answers that will help you

separate the tasks that NEED to be trained from those that COULD be trained. The

questions will also help you determine the amount of time to spend on training each task

(if everyone performs the task, and it is hard to learn, then you need more time to train

for that task; a task that few people perform, and that is easy to learn and be proficient at

will need less time in training, if it is trained at all). The answers to each area can be

customized for your organization under Customizations > Lists > Task Analysis

Content .
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· KSAs - the supporting knowledge, skill, and ability statements that support the task,

selected from the KSAs in LEAD. You can easily add KSA entries on the Library  tab.

· Interventions  - any existing interventions that support the task, selected from the

Interventions in LEAD. You can easily add interventions entries on the Library  tab.

On this screen you can:

· View the information by clicking on the Task folder.

· Edit the information.

· Add a New subtask, based on the selected task (and competency).

· Resequence  the subtasks below the task folder in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the skill hierarchy.

· Delete the selected task (including all subtasks, and steps under the task).

· Select Explain Flag  to review the reasons the task has been flagged.

3.1.3.4   Subtask
Subtasks are major parts of a task. Depending on the competency statement, you may want

to create subtasks to break up the main task. You can also break down a subtask into two or

more steps, if needed. The Subtask screen has two tabs that you can minimize to see just the

information you are working on:

· Subtask  - for the main information about the subtask.

· Subtask Attributes  - to list the conditions and standards under which the subtask is

performed on the job, along with any resources that someone would have available when

they do the subtask on the job. Conditions  and Standards  can be added to the

Library in LEAD, while Resources  are listed in their respective categories on the

Resources tab.

· Interventions  - any existing interventions that support the subtask, selected from the

Interventions in LEAD. You can easily add interventions entries on the Library  tab.

On this screen you can:

· View the information by clicking on the Subtask folder.

· Edit the information.

· Add a New step, based on the selected subtask (and competency).

· Resequence  the steps below the Subtask folder in the tree structure.
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· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the skill hierarchy.

· Select Delete the selected subtask (including all steps under the subtask). 

· Explain Flag  to review the reasons the subtask has been flagged.

3.1.3.5   Step
A step is a major part of a subtask and the most specific form of behavior, and the smallest

component defined in the task analysis. The Step screen has two tabs that you can minimize

to see just the information you are working on:

· Step  - for the main information about the step.

· Step Attributes  - to list the conditions and standards under which the step is performed

on the job, along with any resources that someone would have available when they do

the step on the job.  Conditions  and Standards  can be added to the Library in LEAD,

while Resources  are listed in their respective categories on the Resources tab.

· Interventions  - any existing interventions that support the task, selected from the

Interventions in LEAD. You can easily add interventions entries on the Library  tab.

On this screen you can:

· View the information by clicking on the Step folder.

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the skill hierarchy.

· Delete the selected step.

· Select Explain Flag  to review the reasons the step has been flagged.

3.1.3.6   Adding Conditions, Standards, and Resources
Tasks, subtasks, and steps allow you to add the:

· Conditions under which the skill is performed.

· Standards to which the skill should be performed.

· Resources that are needed or support the skill when it is being performed.
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Conditions  and Standards  need to be added to the Library tab, while Resources  need

to be created on the Resources tab, before they can be selected on the Task, Subtask, or Step

Attributes tab.

3.1.3.7   Adding Knowledge, Skills, and Abilities
Tasks allow you to list the:

· Knowledge that is needed to perform the task. 

· Skills that are needed to perform the task. 

· Abilities that are needed to perform the task.

Knowledge , Skills , and Abilities  (KSAs) need to be created on the Library  tab,

before they can be selected on the KSAs tab of a task.

3.1.3.8   Adding Interventions
Tasks, subtasks, and steps allow you to list any existing interventions that support the skill.

Interventions  need to be created on the Library  tab, before they can be selected on the

KSAs tab of a task.

3.1.3.9   Selecting from Competencies
There are two ways to select a Competency for a task in LEAD: 

· If you want to add new tasks that are linked to the O*Net Competencies , select Create

From Competencies on the Task Analysis, Job, or Duty folders. This allows you to make

multiple selections to create new tasks for your skill hierarchy. 

· If you need to change the selected competency for a task (and its subtasks and steps),

first select Edit to edit the task, then select Edit under the "This item was created from

Competencies." text. This allows you to change or select a competency the task is based

on.

Either way will open the Competency Selection screen which shows the Major Occupation,

Minor Occupation, Broad Jobs, and Jobs in the tree structure. Underneath each Job you will

see the Tasks listed, along with folders for the Knowledge, Skills, and Abilities listings.

Select the tasks, knowledge, skills, or abilities entry or entries you need by selecting the

checkbox(es) and then selecting Save.

3.1.4   Documents

Under the Documents folder, you have two options:
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· Training Needs Analysis - a PDF document of the information contained in the Training

Needs Analysis folders, this will always output the current TNA, whether that's the first

TNA or the latest Modification TNA.

· Skill Hierarchy - a spreadsheet of the information contained in the Task Analysis folders.

Select the document you wish to create in the tree structure. Then select Print Preview to

generate the document.

3.2 Objectives

On the Objectives tab, you can build the learning objectives based on your completed task

analysis. LEAD will automatically generate the learning objectives by using the verb, skill text,

and any selected conditions and standards from the task, subtask, and step information you

entered for the task analysis. A task becomes a Terminal Objective (TO), while subtasks and

steps become Enabling Objectives (EOs). From this baseline, you can change the objective

type from Terminal to Enabling or vice versa. You can also change the Skill Basis the objective

is based on (i.e., the task, subtask, or step), where an objective can be based on more than

one skill). An objective can also be based on the Knowledge, Skills, and Abilities (KSAs) entries

of a task (and yes, you can select more than one KSA for an objective).

In the Design tab > Curriculum Development folder you will build out the table of contents

structure. The Scope of the initiative determines what each level in the table of contents

structure is named. In that table of contents structure, the EO is linked to the lowest level (e.g.,

Section), while a TO is linked one level higher, i.e., to the second lowest level (e.g., Lesson). 

Note: Each TO must have at least one EO associated (underneath) with it. If the scope of your

initiative is set to: Lesson, Distance Learning Lesson, Mentoring, or Workshop, you can have

only ONE TO. You can have as many EOs as you would like. All other initiative scopes allow

you to have as many TOs and EOs as you can come up with (and as you need).

In general, learning objectives should state what the participant will be able to do after they

complete a piece of learning content, using the construct of:

· Condition, under which the participant will be required to perform the desired behavior -

this could be a list of things they are allowed to use, or not allowed to use, or it could be

a location or time of day

· Behavior, what the participant will be required to be able to do 

· Standard, to which the participant should perform the behavior - this should be

measurable! That is why LEAD does not come with the verbs "Understand" or "Know" as

standard, as those are not measurable
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However, this will depend on your organization's standards for learning objectives. Some

organizations want very specific learning objectives, while others only want to see those

conditions and standards that are different from the expected conditions (e.g., in a classroom)

and standards (e.g., without errors).

Once you've added the automatically generated objectives using Add Missing, you can: 

· View the objective

· Edit the objective, including the:

o Objective text

o Objective type (TO or EO)

o Skill basis of the objective; an objective can be based on one or more skills or KSA

entries from the task analysis

o Assessment information, including the learning domain, passing criteria, and criticality

index information, and for EOs also test item type and number of test items

· Select Show History  to review the changes made to the objective, including the user

name and date/time of saved changes, and revert to an earlier saved revision 

· Delete the selected objective, as long as it is not linked/used in the Curriculum

Development folder on the Design tab

· Add a New objective, based on one or more skills or KSA entries from the task analysis

· Resequence  the objectives in the teaching or learning order

· Print Preview the Objective Assessment Information spreadsheet that is generated to list

all objectives, along with the assessment information that is gathered for the objective

· Add Missing to add objectives, after amending the task analysis on the Analysis tab.

· Select Explain Flag  to review the reasons the objective has been flagged

3.2.1   Viewing or Editing Terminal Objectives

When you view or edit a Terminal Objective (TO), you see a tabbed screen. When editing,

you can make the desired changes to the TO to match your needs. There are several

tabs/areas on this screen:

· General tab - the text of the objective, version, and type of objective.

· Skill Basis tab - the skill basis of the objective.

· Assessment tab - information about how the objective should be assessed.
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3.2.2   Viewing or Editing Enabling Objectives

When you view or edit an Enabling Objective (EO), you see a tabbed screen. When editing,

you can make the desired changes to the EO to match your needs. There are several

tabs/areas on this screen:

· General tab - the text of the objective, version, and type of objective.

· Skill Basis tab - the skill basis of the objective.

· Assessment tab - information about how the objective should be assessed.

3.2.3   Selecting the Skill Basis

On the Skill Basis Selection screen, you can select the skill basis for a learning objective. An

objective can be based on one or more tasks, subtasks, or steps. An objective can also be

based on one or more of the knowledge, skill, or ability entries that were selected for a task

in the task analysis.

3.3 Design

On the Design tab, you can manage your initiative, complete the Training Management

Document, lay out the table of contents for your Curriculum Development initiative, including

detailed design information, and develop the Testing Plan. You can also generate the design

documents under the Documents folder. 

Use the tree structure to expand out the five main folders and get to the data you need to

work with. To make more room to see items in the tree structure, click and drag the bottom

right corner of the tree window (or frame). If you need even more space, click on the three-

bar icon (hamburger icon) next to LEAD in the header bar to minimize the main menu to show

only the icons. To see all of the menu items again, click on the hamburger icon again.

3.3.1   Initiative Management

When you click on the Initiative Management folder, you can edit information about the

initiative, and when you expand the folder, you can manage the Team Members, Assignments,

and Resources for the initiative. You can access this folder from both the Initiatives > Analysis

and the Initiatives > Design screens.

3.3.1.1   Team Members
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The Team Members screen lists the users currently assigned to the initiative. You can access

this folder from both the Initiatives > Analysis > Initiative Management and the Initiatives >

Design > Initiative Management screens. 

3.3.1.2   Assignments

The Assignments screen lists all the assignments that have been created for the initiative. You

can access this screen from both the Initiatives > Analysis > Initiative Management and the

Initiatives > Design > Initiative Management screens. On this screen you can:

· Create a New assignment.

· Select an assignment and:

o View the detailed information of the assignment.

o Edit the assignment information.

o Select Show History  to review the changes made to the assignment, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete an assignment.

3.3.1.3   Resource Management

On the Resource Management screen, you can review, view, and update any resources that

are cited anywhere in the initiative. This includes resources cited in the:

· TNA or TMD Resources screen under the Training Data folder, or for a specific Initiative

Location.

· Task Analysis for a Task, Subtask, or Step.

· And on the Develop tab:

o Sub-Elements: Page / Paragraph / Caution / Note / Warning.

o Sheets.

o Certain Test Items.

o Storyboard.

o Test Instructions.

On this screen:

· Use the Type drop-down to limit the list of resources to a specific sub-category, as set up

on Customization  screens. 
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· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. 

· Select the Show Out-of-Date Resources Separately check box to see those outdated

resources at the top of the list grouped under: Items to Update. 

· Export a spreadsheet listing all cited resources.

· View the different versions of a resource by clicking on the arrow in the first column.

· Select a resource and then: 

o Generate a Related Materials Report that lists every place within the initiative where the

selected resource is cited or used.

o Generate an Impact Report that lists every place within the initiative where any previous

version of the selected resource is cited or used.

o Update  to the latest version of a resource.

o View the resource information.

o Edit the resource information if the resource is not approved.

Note: This will update the resource everywhere it is used in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.

3.3.2   Training Management Document

The Training Management Document (TMD) is the output of the Design phase that outlines

the content, structure, and management information for the initiative. When you click on the

TMD folder, you can edit information about the initiative, and when you expand the folder,

you can capture the information required for the TMD in the folders/fields under the TMD.

Several fields are shared with the Training Needs Analysis (TNA) and are editable in both

areas, until the TNA is approved. Once the TNA has been approved, changes to the shared

fields will only be reflected in the TMD. 

Shared fields include the Changes from Previous Version tab on Justification screen, as well as

the Initiative Overview, Target Audience, Qualification Earned, and Associated Learning Events

fields, and the information under the Training Data folder. The TMD adds Foreword and

Purpose of Initiative fields, along with a Schedule of the learning events under the Training

Data folder.

19
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3.3.2.1   Foreword (TMD Only)
On the Foreword screen, you can explain any unique aspects of the learning event, which may

not be clear from the information that is provided in the rest of the document. 

You can:

· View the foreword by clicking on the Foreword folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.2   Changes from Previous Version (TMD Only)
The Changes from Previous Version lists the required and recommended changes to the new

version of the existing learning event.

You can:

· View the information by clicking on the Changes from Previous Version folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.3   Initiative Overview (TNA and TMD)
On the Initiative Overview screen, you can enter a description, or overview, of the proposed

learning event that will close the performance gap.

You can:

· View the information by clicking on the Initiative Overview folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.4   Purpose of Initiative (TMD Only)
On the Purpose of Initiative screen, you can provide a summary of the reasons why the

initiative is being/or has been developed from the training needs analysis. This can help

someone unfamiliar with the initiative with some background information.

You can:

· View the information by clicking on the Purpose of Initiative folder.

· Edit  the information.
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· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.5   Target Audience (TNA and TMD)
On the Target Audience screen, you can describe who the learning event is for and how many

people are in the target audience.

You can:

· View the information by clicking on the Target Audience folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.6   Qualification Earned (TNA and TMD)
On the Qualification Earned screen, you can list any qualification(s) or certification(s) that a

participant earns by completing the learning event.

You can:

· View the information by clicking on the Qualification Earned folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.7   Associated Learning Events (TNA and TMD)
On the Associated Learning Events screen, you can list any associated learning events to the

current initiative, including:

· Prerequisite learning events that participants must or should complete before they can

attend this learning event or initiative.

· Equivalent learning events that participants can complete instead of this learning event or

initiative.

· Follow-on learning events that participants can or should complete after they completed

this learning event or initiative.

You can:

· View the information by clicking on the Associated Learning Events folder.

· Edit  the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.
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3.3.2.8   Training Data (TNA and TMD)

The Training Data screen lists the current and planned data for the learning event, including

expected length, number of hours, minimum and maximum capacities, number of convenings

(how often the learning event will be delivered), and the expected throughput of participants.

You can view the information by clicking on Training Data in the tree structure, once there

you can:

· Edit the training data. 

· Select Show History  to review the changes made to the training data, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

In the screens underneath the Training Data screen, you can enter information about the:

· Schedule for delivering the learning event (in the TMD only).

· Facilities needed to deliver the learning event.

· Funding needed to develop and/or deliver the learning event.

· Personnel needed to deliver the learning event.

· Resources needed to deliver the learning event.

3.3.2.8.1   Schedule (TMD Only)

On the Schedule screen, you can assign times to the table of contents of your learning event,

specifically Overview, Enabling Objective Level items, Summary and Assessments, as well as

schedule events that are not linked to a table of contents item (like administrative time or

other time you wish to capture in the schedule, like breaks or lunch). For each entry on the

schedule, you can enter when the event should take place (week and day), select the type of

event it is, enter a time in hours and minutes, and the instructor or facilitator to participant

ratios. You can have more than one type of event per schedule item by adding additional

schedule events for that schedule item.

On this screen you can:

· View the schedule by selecting Schedule under the Training Data folder.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Edit the information.

· Add New schedule entries, based on a table of contents item or none (for schedule

events not linked to a table of contents item).

· Delete a selected schedule entry from the list.
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· Resequence  the scheduled events.

· Use Add Missing to add any missing table of contents items to the schedule automatically.

· Update a selected schedule entry's linked table of contents item.

You can manage the schedule event types that are listed on this screen on the

Customization  tab. The timings you provide on this screen display for the table of contents

items on the Initiatives > Design > Curriculum Development screens and on the Initiatives >

Develop screens. 

3.3.2.8.2   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. On this screen you can:

· View the facility information by selecting Facilities under the Training Data folder.

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.8.3   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Training Data >

Funding screen, so if you changed the year by mistake you can return to the previous

selected year without a loss of data. The fiscal year used in LEAD is whatever fiscal year your

organization uses. On the Funding screen you can:

· View the funding information by selecting Funding under the Training Data folder.

· Edit the information.

· Add New funding or expense rows in the table.

· Delete funding or expense rows in the table.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.
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3.3.2.8.4   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. In LEAD, you can list the personnel requirements

for four types of personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.

On this screen you can:

· View the personnel information by selecting Personnel under the Training Data folder.

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.8.5   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during development.

On this screen you can:

· View the selected resource list by selecting Resources under the Training Data folder.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Select a resource and then: 

o Generate a Related Materials Report that lists every place within the initiative where the

selected resource is cited or used.

o Update  to the latest version of a resource.

o View a selected resource.

· Edit the resource list:
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o On Hand and Required quantities.

Note: If a resource is missing in the output of the TNA or TMD, but is listed on the

screen, check the Required quantity. If the Required quantity is set to 0, it will not output

in the TNA or TMD. 

o Delete a selected resource from the list (provided it is not selected or cited on the

Develop tab).

o Select resources  for the list.

3.3.2.9   Initiative Locations (TNA and TMD)

On the Initiative Locations screen, you can select the initiative locations where training will

take place. All data from the Training Data screen and sub-folders will be copied to a newly

selected initiative location. You can add a New initiative location to the TNA or TMD from this

screen. Initiative Locations are created on the Admin > Locations  screen.

Once you selected the initiative location, you can:

· View the initiative location's information, including the current and planned data for the

learning event, including expected length, number of hours, minimum and maximum

capacities, number of convenings (how often the learning event will be delivered), and

the expected throughput of participants.

· Edit the initiative location's information.

· Select Show History  to review the changes made to the initiative location, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Delete the selected initiative location from the initiative.

In the screens underneath the selected initiative location, you can enter information about

the:

· Schedule for delivering the learning event (in the TMD only).

· Facilities needed to deliver the learning event at that initiative location.

· Funding needed to deliver the learning event at that initiative location.

· Personnel needed to deliver the learning event at that initiative location.

· Resources needed to deliver the learning event at that initiative location.

3.3.2.9.1   Schedule (TMD Only)

On the Schedule screen for each Initiative Location, you can edit when the event should take

place (week and day) and change the instructor or facilitator to participant ratios of the

standard schedule that are set up on the Schedule screen under the Training Data folder. 
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On this screen you can:

· View the schedule by selecting Schedule under the Initiative Location folder.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Edit some of the standard schedule information, as well as all of the information of

Initiative Location specific schedule entries.

3.3.2.9.2   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. When you first add a new Initiative Location, the data is copied from the Training Data

> Facilities screen for you to edit for the specific Initiative Location. On this screen you can:

· View the facility information by selecting Facilities under the [Selected Initiative Location]

> Initiative Locations folder.

· Edit the information copied from the Training Data > Facilities screen.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.9.3   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Initiative Locations >

[Selected Initiative Location] >Funding screen, so if you changed the year by mistake you can

return to the previous selected year without a loss of data. The fiscal year used in LEAD is

whatever fiscal year your organization uses. When you first add a new Initiative Location, the

data is copied from the Training Data > Funding screen for you to edit for the specific

Initiative Location. On the Funding screen you can:

· View the funding information by selecting Funding under the selected Initiative Location.

· Edit the information copied from the Training Data > Funding screen.

· Add New funding or expense rows in the table.

· Delete funding or expense rows in the table.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.
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3.3.2.9.4   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. When you first add a new Initiative Location, the

data is copied from the Training Data > Personnel screen for you to edit for the specific

Initiative Location. In LEAD, you can list the personnel requirements for four types of

personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.

On this screen you can:

· View the personnel information by selecting Personnel under the selected Initiative

Location.

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.2.9.5   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during development.

When you first add a new Initiative Location, the data is copied from the Training Data >

Resources screen for you to edit for the specific Initiative Location. On this screen you can:

· View the selected resource list by selecting Resources under the selected Initiative

Location. 

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Select a resource and then: 
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o Generate a Related Materials Report that lists every place within the initiative where the

selected resource is cited or used.

o View a selected resource. 

· Edit the resource list:

o On Hand and Required quantities

Note: If a resource is missing in the output of the TNA or TMD, but is listed on the

screen, check the Required quantity. If the Required quantity is set to 0, it will not output

in the TNA or TMD. 

o Select resources  for the list.

o Delete a selected resource from the list (provided it is not selected or cited on the

Develop tab and it was added only for this Initiative Location).

3.3.3   Curriculum Development

Under the Curriculum Development folder, you can build the table of contents structure for

your initiative. The scope of the initiative determines what the individual elements of the

structure are called:

Course / Distance Learning Course

· Module(s) - a grouping of one or more lessons 

o Lesson(s) - a grouping of one or more sections; each lesson is linked to a terminal

objective 

§ Overview - each lesson has one overview area for content

§ Section(s) - each lesson has one or more sections that contain the actual content of

the course; each section is linked to an enabling objective

§ Summary - each lesson has one summary area for content

Module / Distance Learning Module

· Lesson(s) - a grouping of one or more sections; each lesson is linked to a terminal

objective 

o Overview - each lesson has one overview area for content

o Section(s) - each lesson has one or more sections that contain the actual content of

the course; each section is linked to an enabling objective

o Summary - each lesson has one summary area for content

Lesson / Distance Learning Lesson - linked to one terminal objective

· Overview - the lesson has one overview area for content

· Section(s) - the lesson has one or more sections that contain the actual content of the

lesson; each section is linked to an enabling objective

· Summary - the lesson has one summary area for content
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Manual

· Section(s) - a grouping of one or more chapters; each section is linked to a terminal

objective 

o Overview - each section has one overview area for content

o Chapter(s) - each section has one or more chapters that contain the actual content of

the course; each chapter is linked to an enabling objective

o Summary - each section has one summary area for content

Mentoring - linked to one terminal objective

· Overview - there is one overview area for content

· Subject(s) - there are one or more subjects that contain the actual content; each

subject is linked to an enabling objective

· Summary - there is one summary area for content

On-the-Job-Training (OJT)

· Level(s) - a grouping of one or more procedures; each procedure is linked to a

terminal objective

o Overview - each level has one overview area for content

o Procedure(s) - each level has one or more procedures that contain the actual

content of the level; each procedure is linked to an enabling objective

o Summary - each level has one summary area for content

Performance Support

· Module(s) - a grouping of one or more procedures; each procedure is linked to a

terminal objective

o Overview - each module has one overview area for content

o Procedure(s) - each module has one or more procedures that contain the actual

content of the level; each procedure is linked to an enabling objective

o Summary - each module has one summary area for content

Workshop - linked to one terminal objective

· Overview - the workshop has one overview area for content

· Section(s) - the workshop has one or more sections that contain the actual content of

the lesson; each section is linked to an enabling objective

· Summary - the workshop has one summary area for content

To make life easier, use Add Missing to automatically create the basic structure based on the

objectives. If your scope is some kind of course, a default Module is added. You can then

choose to add additional modules to group the lessons in your course. Once you've built the

basic structure, you have the following actions available to you:

· Add a New Module or Assessment.
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· View the table of contents item by clicking on the relevant folder.

· Edit the information (including the title).

· Resequence  the items below the selected item in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Delete an item at the module level or below (provided no content exists yet).

· View/Edit the Design Considerations as every level that gather information about the

table of contents item to help with the development of the learning event.

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· Add Missing to create new table of contents items based on newly added learning

objectives.

3.3.3.1   Course Level

Only initiatives with a Scope of Course or Distance Learning Course have a course level. On

this screen, you can use Add Missing to automatically create the basic table of contents

structure based on the objectives. A default Module is added automatically. You can then

choose to add additional modules to group the lessons in your course. Once you've built the

basic structure, you have the following actions available to you:

· Add a New Module  or Assessment .

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title for modules and below, but not the Status -

you can edit the Status on the Develop tab).

· Resequence  the items below the selected item in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Delete an item at the module level or below (provided no content exists on the Develop

tab).

· Select Explain Flag  to review the reasons the table of contents item has been flagged.
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· Select Add Missing to create new table of contents items based on newly added learning

objectives.

· View/Edit the Design Considerations  at every level that gather information about the

table of contents item to help with the development of the learning event. 

3.3.3.2   Module Level

Only initiatives with a Scope of Course, Distance Learning Course, Module, or Distance

Learning Module have a module level. On this screen, you can use Add Missing to

automatically create the basic table of contents structure based on the objectives. Once

you've built the basic structure, you have the following actions available to you:

· Add a New Assessment .

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title for modules and below, but not the Status -

you can edit the Status on the Develop tab).

· Resequence  the items below the selected item in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision. 

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Delete an item at the module level or below (provided no content exists on the Develop

tab).

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· Add Missing to create new table of contents items based on newly added learning

objectives (this is only available for the highest-level folder, for a Module, or Distance

Learning Module initiative).

· View/Edit the Design Considerations  at every level that gather information about the

table of contents item to help with the development of the learning event.

3.3.3.3   Terminal Objective Level

All initiatives have at least one Terminal Objective (TO) Level, though the name will vary

depending on the Scope of the initiative (later called TO Level Name for field titles):

· Course / Distance Learning Course: Lesson

· Module / Distance Learning Module: Lesson

· Lesson / Distance Learning Lesson: Lesson
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· Manual: Section

· Mentoring: Mentoring

· On-the-Job Training (OJT): Level

· Performance Support: Module

· Workshop: Workshop

On this screen, you can use Add Missing to automatically create the basic table of contents

structure based on the objectives. Once you've built the basic structure, you have the

following actions available to you:

· Add a New Assessment .

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title, but not the Status - you can edit the Status on

the Develop tab).

· Resequence  the items below the selected item in the tree structure.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Delete an item at the terminal objective level or below (provided no content exists on the

Develop tab).

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· Add Missing to create new table of contents items based on newly added learning

objectives.

· View/Edit the Objective information by selecting the link.

· View/Edit the Design Considerations  at every level that gather information about the

table of contents item to help with the development of the learning event.

3.3.3.4   Overview/Summary

Underneath the Terminal Objective Level , you will see an Overview folder prior to the

Enabling Objective Level(s)  and a Summary folder at the end. On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title, but not the Status - you can edit the Status on

the Develop tab).
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· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Select Explain Flag  to review the reasons the Overview or Summary has been flagged.

· View/Edit the Design Considerations  at every level that gather information about the

table of contents item to help with the development of the learning event.

3.3.3.5   Enabling Objective Level

All initiatives have one or more Enabling Objective (EO) Levels, though the name will vary

depending on the Scope of the initiative (later called EO Level Name for field titles):

· Course / Distance Learning Course: Section

· Module / Distance Learning Module: Section

· Lesson / Distance Learning Lesson: Section

· Manual: Chapter

· Mentoring: Subject

· On-the-Job Training (OJT): Procedure

· Performance Support: Procedure

· Workshop: Section

On this screen, you have the following actions available to you:

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title, but not the Status - you can edit the Status on

the Develop tab).

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Delete an item at the enabling objective level (provided no content exists on the Develop

tab).

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· View/Edit the Objective information by selecting the link.
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· View/Edit the Design Considerations  at every level that gather information about the

table of contents item to help with the development of the learning event.

3.3.3.6   Assessment

Assessments can be added under the Curriculum Development folder to be at the same level

as a Module (if you have that level in your initiative), or on the same level as a terminal or

enabling objective. You can select which enabling objectives will be tested in the assessment

in the Objectives tab, where you will see all objectives at the same level or below the selected

level in the tree structure. On this screen, you can:

· View the assessment information by clicking on the assessment.

· Edit  the information (including the title, but not the Status - you can edit the Status on

the Develop tab).

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the table of contents outline (structure of your initiative with applicable

objectives).

· Delete the assessment (provided no content exists on the Develop tab).

· Select Explain Flag  to review the reasons the assessment has been flagged.

· View the Objective  information by selecting View.

· View/Edit the Test Design Considerations .

3.3.4   Testing Plan

On the Testing Plan screen, you can gather information about the overall assessment plan for

the initiative (if any). This includes the following information:

· Minimum Passing Grade - captures information about the minimum passing grade

required to pass the initiative.

· Justification / Comments - captures any information needed to justify the minimum

passing grade, along with any other comments about the testing plan.

· Test Procedure - captures the overarching testing procedure for the initiative; you can

capture test instructions for each assessment separately in the Develop tab.

· Matrix - lists all the assignments that were created under the Curriculum Development

folder and allows you to assign a weight to them that can be used to determine the

overall/final grade a participant receives.

 On these screens you have the following actions available to you:
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· View the information by selecting the relevant folder.

· Edit the information.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

· Print Preview the testing plan.

3.3.4.1   Test Matrix
On the Test Matrix screen, you can assign a weight to each assessment that was created under

the Curriculum Development folder. This weight can be used to determine the overall/final

grade a participant receives. On this screen you can:

· View the information.

· Edit weight assigned to each assessment.

· Select Show History  to review the changes made to the information, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

3.3.5   Documents

Under the Documents folder, you have several options:

· Objective Assessment Information - a spreadsheet that contains the objectives along with

their assessment information, as detailed on the Objectives tab.

· Training Design Document - a PDF document of the table of contents under the

Curriculum Development folder, along with the objectives, the design considerations,

assessment information, and the test design considerations.

· Training Management Document - a PDF document of the information listed under the

Training Management Document, plus the table of contents under the Curriculum

Development folder, along with the objectives.

· Testing Plan - a PDF document of the information listed under the Testing Plan folder.

· Training Outline - a spreadsheet listing the table of contents under the Curriculum

Development folder, along with their status and their objectives.

· Traceability Matrix - a spreadsheet listing the table of contents under the Curriculum

Development folder on the Design tab, the objectives for each applicable table of

contents item, the skills of the task analysis that support the objectives, along with the

competencies that the skills are based on.

Select the document you wish to create in the tree structure. Then select Print Preview to

generate the document.
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3.4 Develop

On the Develop tab, you add the actual content to your initiative. Based on the Curriculum

Development tree structure you created on the Design tab, you can now add the following

content:

· Front Matter  information for the output generated for the instructor/facilitator and the

participants with predefined Elements  (or headings) to which you can add paragraphs,

notes, cautions, or warning)s .

· Terminal Objective Level  entries (i.e., Lessons) have Overview and Summary folders

before and after the Enabling Objective Level entries (i.e., Sections).

· Overview and Summary folders to which you can add Elements  (or main headings),

under which you can add paragraphs, notes, cautions, or warning)s .

· Enabling Objective Level  entries (i.e., Sections) contain the actual learning content,

including:

o Sheets  that will print in the Participant Guide (or similar output).

o Elements  (or main headings) for the content structure, based on the content type,

under which you can add paragraphs, notes, cautions, or warning)s .

o Practice test items , which will print in the output for the instructor/facilitator.

o Assessment test items , which will output in an assessment.

· Assessment  entries that allow you to edit the test instructions for a given assessment.

Use the tree structure to expand out the folders and get to the data you need to work with.

To make more room to see items in the tree structure, click and drag the bottom right corner

of the tree window (or frame). If you need even more space, click on the three-bar icon

(hamburger icon) next to LEAD in the header bar to minimize the main menu to show only the

icons. To see all of the menu items again, click on the hamburger icon again.

3.4.1   Front Matter

On the folders and screens below the Front Matter folder, you can edit the front matter text

that is output in the Instructor Guide (IG) and the Participant Guide (PG). As part of the

Customizations  of LEAD, three default elements (headings) with default paragraphs

(subheadings) and corresponding text entries have been set up for the front matter:

· IG

o How to Use the Instructor Guide

· PG

o How to Use the Participant Guide
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o Safety Hazard Awareness

o Security Awareness

o Safety Hazard Awareness

o Security Awareness

3.4.2   Course Level

Only initiatives with a Scope of Course or Distance Learning Course have a course level. On

this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title for modules and below).

· Print Preview  the Instructor Guide, Participant Guide, or test items

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG. 

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· View the Cited Resources  at every level that lists all resources used or cited anywhere

below the selected table of contents item on the Develop tab. 

· View the Design Considerations  at every level that gather information about the table

of contents item to help with the development of the learning event.

3.4.3   Module Level

Only initiatives with a Scope of Course, Distance Learning Course, Module, or Distance

Learning Module have a module level. On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title for modules and below).

· Print Preview  the Instructor Guide, Participant Guide, or test items for this table of

contents item.

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG. 

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· View the Cited Resources  at every level that lists all resources used or cited anywhere

below the selected table of contents item on the Develop tab. 

· View the Design Considerations  at every level that gather information about the table

of contents item to help with the development of the learning event.

56

66

110

66

56

56

66

110

66

56



57

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2022 Aimereon

Initiatives

3.4.4   Terminal Objective Level

All initiatives have at least one Terminal Objective (TO) Level, though the name will vary

depending on the Scope of the initiative (later called TO Level Name for field titles):

· Course / Distance Learning Course: Lesson

· Module / Distance Learning Module: Lesson

· Lesson / Distance Learning Lesson: Lesson

· Manual: Section

· Mentoring: Mentoring

· On-the-Job Training (OJT): Level

· Performance Support: Module

· Workshop: Workshop

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title).

· Print Preview  the Instructor Guide, Participant Guide, or test items for this table of

contents item.

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG.

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· View the Cited Resources  at every level that lists all resources used or cited anywhere

below the selected table of contents item on the Develop tab. 

· View the Objective information.

· View the Design Considerations  at every level that gather information about the table

of contents item to help with the development of the learning event.

· View the Skill Basis that the terminal objective level is based on.

3.4.5   Overview/Summary

Underneath the Terminal Objective Level  you will see an Overview folder prior to the

Enabling Objective Level(s)  and a Summary folder at the end. On the screens below the

Overview and Summary folders, you can edit the overview and summary text for the terminal

objective level. There is one predefined element for each folder, Introduction for the

Overview folder, and Review for the Summary folder. 
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On this screen, you can: 

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title).

· Add a New element (heading).

· Resequence  the items below the selected item in the tree structure.

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· View the Cited Resources  at every level that lists all resources used or cited anywhere

below the selected table of contents item on the Develop tab. 

· View the Design Considerations  at every level that gather information about the table

of contents item to help with the development of the learning event.

3.4.6   Enabling Objective Level

All initiatives have one or more Enabling Objective (EO) Levels, though the name will vary

depending on the Scope of the initiative (later called EO Level Name for field titles):

· Course / Distance Learning Course: Section

· Module / Distance Learning Module: Section

· Lesson / Distance Learning Lesson: Section

· Manual: Chapter

· Mentoring: Subject

· On-the-Job Training (OJT): Procedure

· Performance Support: Procedure

· Workshop: Section

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit  the information (including the title).

· Add New elements  that will contain the content in Pages or Paragraphs  and

provide notes, cautions, or warnings, as well as test items  for the Practice or

Assessment elements.

· Resequence  the elements below the selected item in the tree structure.

· Print Preview  the Instructor Guide, Participant Guide, or test items for this table of

contents item.
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Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG.

· Select Explain Flag  to review the reasons the table of contents item has been flagged.

· View the Cited Resources  at every level that lists all resources used or cited anywhere

below the selected table of contents item on the Develop tab. 

· View the Objective information.

· View the Design Considerations  at every level that provide information about the table

of contents item to help with the development of the learning event.

· View the Skill Basis that the enabling objective level is based on.

Underneath the EO Level in the tree structure, you will see:

· a Sheets  folder that lists any Participant Guide sheets (or handouts) that are linked to

this EO.

· the required elements (headings) as determined by the Content Type set for this EO level

on the Objective or Design tabs.

o underneath each element you can create Pages and Paragraphs (subheadings) for the

content, including Text and links to Resources and Sheets; Pages and Paragraphs can

also be converted to notes, cautions, or warnings.

o Pages are created for the IMI, Blended, and EPSS Delivery Methods of the EO Level.

o Paragraphs are created for the Instructor-Led Delivery Method of the EO Level.

· a Practice element (if required) for non-graded test items  that will be included in the

Instructor Guide.

· an Assessment element (if required) for graded test items  that will be included in any

assessment  that tests the EO (and not included in the Instructor Guide, though

information about the assessment itself will be included in the Instructor Guide).

For each element (including Practice and Assessment elements) and pages, paragraphs, notes,

cautions, or warnings, you can review the Design Considerations and View/Edit the

Storyboard  for that particular element, page, paragraph, notes, cautions, or warnings. 

3.4.7   Elements

Elements are the major headings for your content. There are predefined elements for the

Front Matter  of the instructor and participant guides. You can create elements for the

Overview and Summary  folders underneath the Terminal Objective Level  and

underneath the Enabling Objective Level . Once you have selected an element, you can:
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· View/Edit the element title and type.

· Add a New page or paragraph  (and convert either one to a note, caution, or warning),

or test item  for the Practice or Assessment elements.

· Resequence  the pages, paragraphs, notes, cautions, or warnings) underneath the

element.

· Select Show History  to review the changes made to the element.

· Delete a selected element.

Note: You cannot delete a required element under the Enabling Objective Level.

· Select Explain Flag  to review the reasons the element item has been flagged.

· View/Edit the Storyboard  for the element.

· View the Design Considerations .

3.4.7.1   Sub-Elements

Underneath the Elements (major headings), you can create as many Pages or Paragraphs

(subheadings) as you need for your content. Pages are primarily meant for on screen display

(like eLearning), while Paragraphs are for printed materials (like the Instructor Guide). 

What you can do with a page or paragraph is identical, just how the information is output and

used is different. Once you have selected a page or paragraph, you can:

· View the title and contents by selecting the page or paragraph.

· Edit the title and type.

· View/Edit the Storyboard  for the page or paragraph.

· Copy/Paste a selected page or paragraph.

· View the Design Considerations .

· Select Show History  to review the changes made to the page or paragraph.

· Delete a selected page or paragraph (including all the content it contains).

· Select Explain Flag  to review the reasons the selected page or paragraph has been

flagged.

· Add a Text  entry.

· Convert a Text entry to a Note, Caution, or Warning entry, which will output the text with

top and bottom lines and a Note, Caution, or Warning icon.

· Add a Resource  entry.
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· View or download a Resource entry, if a link is shown and you have the correct software

available.

· Add a Sheet  entry (for Enabling Objective Level page or paragraph only).

· Select Explain Flag  to review the reasons the selected Text, Note, Caution, Warning,

Resource, or Sheet entry has been flagged.

· Edit a selected Text, Note, Caution, Warning , Resource , or Sheet  entry.

· Delete a selected Text, Note, Caution, Warning, Resource, or Sheet entry.

· Copy/Paste a selected Text, Note, Caution, Warning, Resource, or Sheet entry.

· Move a selected Text, Note, Caution, Warning, Resource, or Sheet entry Up or Down in

the list of entries to resequence the list of entries.

3.4.8   Sheets

Sheets are the handouts to the participants that are collated into the Participant Guide. You

create Sheets by selecting the Sheets folder underneath the Enabling Objective Level  and

then New. A sheet can be cited in a Page or Paragraph  underneath an element of the

same Enabling Objective Level that contains the sheet to provide the instructor or participant

information about how and when to use the sheet. 

To print Sheets, go to the Enabling Objective Level entries (i.e., Sections), Terminal Objective

Level entries (i.e., Lessons), Module Level entries, or the Course Level and select Print Preview. 

Note: If you leave an area (or tab/heading) empty by not adding any entries, then that area

will not output in the PG. 

To copy and paste a sheet from one Enabling Objective Level to anther Enabling Objective

Level, you need to copy the entry under the Page or Paragraph that cites or references the

sheet and paste the entry under a Page or Paragraph to copy both the citation/reference

entry and the sheet at the same time.

On the Sheets screens, you can:

· Add New  sheet.

· Resequence  the sheets to change the order in which they are printed in the Participant

Guide.

· Select Explain Flag  to review the reasons a Sheet has been flagged.

· View a selected sheet.

· Select Show History  to review the changes made to a sheet.
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· Delete a selected sheet.

Note: You cannot delete a sheet that is cited or references in an entry under a Page or

Paragraph.

· Select Explain Flag  to review the reasons the sheet has been flagged.

Expanding the Sheets folder shows the existing sheets. Once you've selected a sheet, you can:

· View/Edit  the sheet title.

· Add a Text  entry to a selected tab (heading).

· Convert a Text entry to a Note, Caution, Warning entry (if you do not need a note,

caution, or warning at the page or paragraph level).

· Add a Resource  entry to a selected tab (heading).

· View or download a Resource entry, if a link is shown and you have the correct software

available.

· Add a Test Item  entry to a selected tab (heading).

· Select Explain Flag  to review the reasons an item on the sheet has been flagged.

· Edit a selected Text, Note, Caution, Warning, Resource, or Test Item entry.

· Delete a selected Text, Note, Caution, Warning, Resource, or Test Item entry.

· Copy/Paste a selected Text, Note, Caution, Warning, Resource, or Test Item entry.

· Move a selected Text, Note, Caution, Warning, Resource, or Test Item entry Up or Down

in the list of entries to resequence the list of entries.

· Select Show History  to review the changes made to the sheet.

· Delete the selected sheet.

3.4.9   Test Items

You can create test items on the Practice and Assessment elements underneath the enabling

objective levels, as well as for Assignment, Job, and Problem Sheets. When it comes to the

output of test items:

· Test items created under a Practice element will output in the Instructor Guide and similar

outputs at the Module, Terminal Objective, and Enabling Objective Levels. You can also

preview the test items for a selected Practice element by selecting Print Preview.

· Test items created under an Assessment element will ONLY output in Assessments  and

Assessment package outputs. You can also preview the test items for a selected

Assessment element by selecting Print Preview.
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· Test items created on Sheets  will output in the Participant Guide and answers to those

test items will output in the back of the Instructor Guide. You can also preview the test

items in the Participant Guide output at the Module, Terminal Objective, and Enabling

Objective Levels.

Once you have selected the practice or assessment element, or are viewing the sheet, you

can:

· View/Edit the practice or assessment title, the sheet information, and the stem(s) of any

test items.

· Add a New test item.

· Select Explain Flag  to review the reasons the test item has been flagged.

· Edit a selected test item entry.

· Delete a selected test item entry.

· Move a selected test item entry Up or Down in the list of entries to resequence the list of

entries.

· Copy/Paste a test item entry.

· Select Show History  to review the changes made to the practice or assessment

element, or the sheet.

· Delete a selected practice or assessment element, or sheet.

Note: Depending on your configuration of LEAD, you may not be able to delete the only

practice or assessment element under the Enabling Objective Level.

· View/Edit the Storyboard  for the test item, practice, or assessment element.

· View the Design Considerations  for the Enabling Objective Level.

3.4.9.1   Essay Question

You can create essay question test items on the Practice and Assessment elements

underneath the enabling objective levels, as well as for Assignment, Job, and Problem Sheets. 

3.4.9.2   Fill-in-the-Blank

You can create fill-in-the-blank test items on the Practice and Assessment elements

underneath the enabling objective levels, as well as for Assignment, Job, and Problem Sheets. 

3.4.9.3   Multiple Choice

You can create multiple-choice test items on the Practice and Assessment elements

underneath the enabling objective levels, as well as for Assignment, Job, and Problem Sheets. 
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3.4.9.4   Performance Job Sheet
 

You can create performance job sheets only on the Assessment elements underneath the

enabling objective level. Performance job sheet test items are not available for Practice

elements or Sheets.

3.4.9.5   Short Answer

You can create short answer test items on the Practice and Assessment elements underneath

the enabling objective levels, as well as for Assignment, Job, and Problem Sheets. 

3.4.9.6   True/False

You can create true/false test items on the Practice and Assessment elements underneath the

enabling objective levels, as well as for Assignment, Job, and Problem Sheets. 

3.4.9.7   Two-Column Matching

You can create two-column matching test items on the Practice and Assessment elements

underneath the enabling objective levels, as well as for Assignment, Job, and Problem Sheets. 

3.4.10   Storyboard

You can enter storyboard information, which allows you to detail how the content should be

implemented, especially for self-paced content that will be developed outside of this

software, at the Element and Page/Paragraph levels in LEAD. This includes the Front Matter

elements, as well as the Overview and Summary elements, along with all elements and test

items at the enabling objective level. On any screen that displays a Storyboard link, click that

link to display the Storyboard screen.

Once you've opened the Storyboard screen, you can:

· Add a Text  entry to a selected tab (heading).

· Convert a Text entry to a Note, Caution, Warning entry. 

· Add a Resource  entry to a selected tab (heading).

· View or download a Resource entry, if a link is shown and you have the correct software

available.

· Select Explain Flag  to review the reasons an item on the storyboard has been flagged.

· Edit a selected Text, Note, Caution, Warning, or Resource entry.

· Delete a selected Text, Note, Caution, Warning, or Resource entry.
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· Copy/Paste a selected Text, Note, Caution, Warning, or Resource entry.

· Move a selected Text, Note, Caution, Warning, or Resource entry Up or Down in the list of

entries to resequence the list of entries.

Select Close to close the Storyboard screen. 

3.4.11   Adding or Editing a Text/Note/Caution/Warning Entry

You can view, add, or edit Text / Note / Caution / Warning entries in several places:

· Design Considerations 

· Sub-Element>: Page / Paragraph / Caution / Note / Warning

· Sheets

· Certain Test Items

· Storyboard

· Test Instructions

· Test Design Considerations

3.4.12   Adding or Editing a Resource Citation/Entry

You can view, add, or edit Resource citations in several places:

· Sub-Element>: Page / Paragraph / Caution / Note / Warning

· Sheets

· Test Items

· Test Instructions

· Storyboard

3.4.13   Selecting Resources on the Develop Tab

You see the Resource Selection screen, when you select the Resource link when adding or

editing a resource entry on: 

· Sub-Element>: Page / Paragraph / Caution / Note / Warning

· Sheets

· Certain Test Items

· Storyboard



66

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2022 Aimereon

Initiatives

· Test Instructions

3.4.13.1   Working with IETM Table of Contents

Once you have selected an IETM on the Resource Selection screen, the IETM Selection screen

pops-up. Use the arrows to expand the IETM Table of Contents to the IETM node(s) you want

to cite. Once you've made your selection, select OK to save it, or select Cancel to return to

the Resource Selection screen.

Note: You can also view the IETM Table of Contents on the Resources > IETMs screen, by

selecting an IETM in the list and then selecting View in the toolbar.

3.4.14   Adding or Editing a Sheet Citation/Entry

You can view, add, or edit Sheet citations in several places:

· Sub-Elements - in Pages and Paragraphs

· Performance Test Items - for Resources and Setup Instructions

3.4.15   Output Options

You will see the Output Options screen in several places:

· When you select Print Preview after selecting a table of contents item on the Develop tab.

· When you select the Instructor Guide or Participant Guide under the Documents folder on

the Develop tab and the select Print Preview.

· When you select any of the following on the Implement tab under the Printed Guides or

Training Packages groups:

o Instructor Guide. 

o Participant Guide.

o Instructor Guide Package.

o Participant Guide Package.

o ILT Package - allows you to select the delivery methods of the EO levels for the IG and

PG separately.

3.4.16   Cited Resources

This screen provides you with the ability to review, view and update any resources that are

cited anywhere below the selected table of contents item on the Develop tab. This screen

shows all the resources cited in:
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· Sub-Element>: Page / Paragraph / Caution / Note / Warning

· Sheets

· Certain Test Items

· Storyboard

· Test Instructions

On this screen:

· Use the Type drop-down to limit the list of resources to a specific sub-category, as set up

on Customization  screens. 

· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. 

· Select the Show Out-of-Date Resources Separately check box to see those outdated

resources at the top of the list grouped under: Items to Update. 

· Export a spreadsheet listing all cited resources for the selected table of contents item and

all items below it in the tree structure.

· View the different versions of a resource by clicking on the arrow in the first column.

· Select a resource and then: 

o Generate a Related Materials Report that lists every place below the selected table of

contents item where the selected resource is cited or used.

o Generate an Impact Report that lists every place below the selected table of contents

item where any previous version of the selected resource is cited or used.

o Update  to the latest version of a resource everywhere the selected resource is cited

below the selected table of contents item. So, if you selected a lesson, selecting Update

would only update to the latest version of the selected resource in that lesson and any

sections within that lesson, but not anywhere else that resource is cited within the

course.

o View the resource information.

o Edit the resource information if the resource is not approved.

Note: This will update the resource everywhere it is used in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.
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3.4.17   Assessment

Assessments can be added under the Curriculum Development folder to be at the same level

as a Module (if you have that level in your initiative), or on the same level as a terminal or

enabling objective. You can select which enabling objectives will be tested in the assessment

in the Objectives tab, where you will see all objectives at the same level or below the selected

level in the tree structure. On this screen, you can:

· View the assessment information by selecting the assessment.

· Edit  the information (including the title).

· View the Objective information.

· Export/generate an Assessment Package containing a preset number of tests and

corresponding answer sheets, along with the proctor instructions.

Note: The Number of Assessment Object Tests to be generated in the Assessment

Package can be set on the Customizations > Configuration tab.

Note: A Performance Assessment will not create multiple versions in the Assessment

Package.

· View the Test Design Considerations  at every level that provide information about the

table of contents item to help with the development of the learning event.

3.4.18   Documents

Under the Documents folder, you have several options:

· Objective Assessment Information - a spreadsheet that contains the objectives along with

their assessment information, as detailed on the Objectives tab.

· Training Design Document - a PDF document of the table of contents items under the

Curriculum Development folder on the Design tab, along with the objectives, the design

considerations, assessment information, and the test design considerations.

· Training Management Document - a PDF document of the information listed under the

Training Management Document, plus the table of contents items under the Curriculum

Development folder on the Design tab, along with the objectives.

· Testing Plan - a PDF document of the information listed under the Testing Plan folder on

the Design tab.

· Training Outline - a spreadsheet listing the table of contents items under the Curriculum

Development folder on the Design tab, along with their status and their objectives.

· Traceability Matrix - a spreadsheet listing the table of contents items under the

Curriculum Development folder on the Design tab, the objectives for each applicable
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table of contents item, the skills of the task analysis that support the objectives, along with

the competencies that the skills are based on.

· Instructor Guide - a PDF document for the instructors to use to instruct/teach the

initiative. You can choose which of the delivery methods of the EO levels to include using

the Output Options .

· Participant Guide - a PDF document for the participants to use while being taught. You

can choose which of the delivery methods of the EO levels to include using the Output

Options .

· Storyboard - a PDF document of the table of contents items under the Curriculum

Development folder on the Design tab, along with the elements, sub-elements and any

storyboard information that was entered.

Select the document you wish to create in the tree structure. Then select Print Preview to

generate the document.

3.5 Implement

On the Implement screen, you can create outputs for a specific initiative. The outputs are

organized in groups on the screen:

· Printed Guides - same output as found on the Develop tab.

o Instructor Guide - a PDF document for the instructors to use to instruct/teach the

initiative. You can choose which of the delivery methods of the EO levels to include

using the Output Options .

o Participant Guide - a PDF document for the participants to use while being taught. You

can choose which of the delivery methods of the EO levels to include using the Output

Options .

· Training Packages - combined outputs to support teaching the content or for further

development.

o Instructor Guide Package - a zip file that includes the IG and IMM to use by the

instructors to instruct/teach the initiative. You can choose which of the delivery

methods of the EO levels to include using the Output Options .

o Participant Guide Package - a zip file that includes the PG and IMM to use by the

participants while being taught. You can choose which of the delivery methods of the

EO levels to include using the Output Options .
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o ILT Package - a zip file that includes the IG, PG, IMM, Testing Plan, and Assessments.

You can choose which of the delivery methods of the EO levels to include using the

Output Options .

o SCORM Package - a SCORM-compliant zip file that can be imported to a Learning

Management System or used for further development in an e-learning tool.

· Management Documents - same output as found on the Analysis and Design tabs.

o Training Needs Analysis - a PDF document of the information contained in the Training

Needs Analysis folders, this will always output the current TNA, whether that's the first

TNA or the latest Modification TNA.

o Training Management Document - a PDF document of the information listed under the

Training Management Document, plus the table of contents under the Curriculum

Development folder, along with the objectives.

o Testing Plan - a PDF document of the information listed under the Testing Plan folder.

· Management Reports - same output as found on the Analysis and Design tabs.

o Skill Hierarchy - a spreadsheet of the information contained in the Task Analysis

folders.

o Objective Assessment Information - a spreadsheet that contains the objectives along

with their assessment information, as detailed on the Objectives tab.

o Traceability Matrix - a spreadsheet listing the table of contents under the Curriculum

Development folder on the Design tab, the objectives for each applicable table of

contents item, the skills of the task analysis that support the objectives, along with the

competencies that the skills are based on.

· Curriculum Outline Documents - same output as found on the Design tab.

o Training Outline - a spreadsheet listing the table of contents under the Curriculum

Development folder, along with their status and their objectives.

o Training Design Document - a PDF document of the table of contents items under the

Curriculum Development folder on the Design tab, along with the objectives, the design

considerations, assessment information, and the test design considerations.

Simply find the output you would like to generate. Select it in the list and select View. If an

output has options, they will show in the Output Options  pop-up for you to set as desired. 

Finding Outputs

If you can't find the output you're looking for, enter a search term in the Find: field and select

Search. The table will list all output that contain your search term on the screen.
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You can also sort the order of the output that is listed on the screen to find the relevant

output. You can click on the column headers of each table to sort the entries by that column.

Clicking on a column header again, will reverse the sort. Small arrows in the column header

let you know which way the data is currently sorted.
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Competencies

This chapter describes the competencies that are available in LEAD, that you can base
your task analysis on.
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4 Competencies

On this screen, you can review the competencies that form the basis of tasks, subtasks, and

steps (aka skills) in the task analysis of the initiative. Those skills are then used as the basis for

the learning objectives, which in turn are the basis for the content in the initiative.

In LEAD, we provide you with the Department of Labor O*NET Tasks, Knowledge, Skills, and

Abilities listing, based on the Department of Labor's (DOL) Standard Occupational

Classification (SOC). You may wish to use the O*NET website: https://www.onetonline.org/ to

find the relevant information for your initiative. You can also review the occupational

information directly in LEAD.

To make more room to see items in the tree structure, click and drag the bottom right corner

of the tree window (or frame). If you need even more space, click on the three-bar icon

(hamburger icon) next to LEAD in the header bar to minimize the main menu to show only the

icons. To see all of the menu items again, click on the hamburger icon again.

The DOL SOC classifies occupations at four levels of aggregation: Major Occupation, Minor

Occupation, Broad Jobs, and Jobs. These groups are reflected in the Type field in LEAD, while

the Major/Minor/Broad/Job Code is the specific code for that job or occupation.  

https://www.onetonline.org/


Resources

This chapter describes the resources available in the software that you can add to and
reuse many times in your initiatives.
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5 Resources

Resources are all the things you use to support the delivery of a learning event. We

recommend that you include those resources that the instructor or facilitator needs to deliver

the learning event and whose costs you want or need to track. Resources are used or cited

extensively in initiatives, specifically, on the following screens:

· Analysis - in the Training Needs Analysis and the Task Analysis.

· Design - in the Training Management Document.

· Develop - in the initiative contents: pages and paragraphs, sheets, and test items.

On the Resources screens you can create and manage the following types of resources:

· Consumables  - any type of resource that is used up during the delivery of a learning

event, e.g., flip chart paper and pens.

· IETMs  - Interactive Electronic Technical Manuals that you can link to a specific node (or

table of contents entry) and launch directly to that specific node during a learning event.

· IMM  - Instructional Media Material are all types of media that can be used in a learning

event, including Microsoft® PowerPoint® slides, graphics, animations, simulations,

videos, and models (whether electronic or physical).

· Publications  - including instructions, manuals, books, articles, websites, and other

published materials.

· Software  - that is needed to deliver or that is used during the learning events, whether

used by the instructor, facilitator, or the participant.

· Tool/Equipment  - includes all tools or equipment that used during the learning event,

including hand tools, power tools, computers, maintenance trainers, and all other kinds of

training equipment.

You can set up the resource sub-categories on the Customization  screens, to enable you

to define groups of resources within the main categories. 

5.1 Consumables

On the Consumables screen, you can create and manage the consumables that are used in

initiatives. Consumables are any type of resource that is used during the delivery of a learning

event and needs to be replenished or replaced at the end of the event, e.g., flip chart paper

and pens, or participant guides and handouts, or oil and oil filters. For each consumable, you

can:

· Add a new consumable to the existing list by selecting + New.
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· Export a spreadsheet listing all consumable entries with all the details in LEAD for each

entry.

· View the different versions of a consumable by clicking on the arrow in the first column.

· Select a consumable and then: 

o Create a New Version  of an approved consumable, which will automatically flag all

initiatives and places within those initiatives where the selected consumable is cited or

used.

o Generate a Related Materials Report that lists every initiative and place within each

initiative where the selected consumable is cited or used.

o Generate an Impact Report that lists every initiative and place within each initiative

where any previous version of the selected consumable is cited or used.

o View the consumable information.

o View and then Approve  the consumable.

o Edit the consumable information.

o Select Show History  to review the changes made to the consumable, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the consumable, if has not been cited in any initiative.

5.2 IETMs

On the IETMs screen, you can add and manage the Interactive Electronic Technical Manuals

(IETMs) that are used in initiatives. The IETM extraction file can be imported into LEAD and

then referenced in the initiative down to a specific node (table of contents item). For each

IETM, you can:

· Add/Import a new IETM by selecting + New.

· Export a spreadsheet listing all IETM entries with all the details in LEAD for each entry.

· View the different versions of an IETM by clicking on the arrow in the first column.

· Select an IETM and then: 

o Create a New Version  of an approved IETM, which will automatically flag all

initiatives and places within those initiatives where the selected IETM is cited or used.

o Generate a Related Materials Report that lists every initiative and place within each

initiative where the selected IETM is cited or used.
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o Generate an Impact Report that lists every initiative and place within each initiative

where any previous version of the selected IETM is cited or used, and whether the cited

node has been modified or deleted.

o View the IETM Table of Contents  by selecting View in the toolbar.

o View the IETM information by selecting View in the Actions column.

o View and then Approve  the IETM by selecting View in the Actions column and then

Approve.

o Edit the IETM information.

o Select Show History  to review the changes made to the IETM, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the IETM, if has not been cited in any initiative.

5.3 IMM

On the IMM screen, you can create and manage the Instructional Media Materials (IMM) that

are used in initiatives. IMM are all types of media that can be used in a learning event,

including Microsoft® PowerPoint® slides, graphics, videos, models (electronic and physical),

and animations. For each IMM, you can:

· Add a new IMM to the existing list by clicking on + New.

· Export a spreadsheet listing all IMM entries with all the details in LEAD for each entry.

· View the different versions of an IMM by clicking on the arrow in the first column.

· Select an IMM and then: 

o Create a New Version  of an approved IMM, which will automatically flag all

initiatives and places within those initiatives where the selected IMM is cited or used.

o Generate a Related Materials Report that lists every initiative and place within each

initiative where the selected IMM is cited or used.

o Generate an Impact Report that lists every initiative and place within each initiative

where any previous version of the selected IMM is cited or used.

o View the IMM information. 

o View and then Approve  the IMM.

o Edit the IMM information, which includes the ability to Update the associated file, as

long as the IMM is not approved.
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o Select Show History  to review the changes made to the IMM, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the IMM, if has not been cited in any initiative.

5.4 Publications

On the Publications screen, you can create and manage the publications that are used in

initiatives. Publications includes all information sources that are not purely media based (like

videos), e.g., books, articles, journals, magazines, manuals, instructions, newspapers, as well as

online information sources, like specific articles on websites or even entire websites (if

appropriate). For each publication, you can:

· Add a new publication to the existing list by clicking on + New.

· Export a spreadsheet listing all publication entries with all the details in LEAD for each

entry.

· View the different versions of a publication by clicking on the arrow in the first column.

· Select a publication and then: 

o Create a New Version  of an approved publication, which will automatically flag all

initiatives and places within those initiatives where the selected publication is cited or

used.

o Generate a Related Materials Report that lists every initiative and place within each

initiative where the selected publication is cited or used.

o Generate an Impact Report that lists every initiative and place within each initiative

where any previous version of the selected publication is cited or used.

o View the publication information.

o View and then Approve  the publication.

o Edit the publication information.

o Select Show History  to review the changes made to the publication, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the publication, if has not been cited in any initiative.
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5.5 Software

On the Software screen, you can create and manage the software that are used in initiatives,

whether by the participant or by the instructor. For each software entry, you can:

· Add a new software to the existing list by clicking on + New.

· Export a spreadsheet listing all software entries with all the details in LEAD for each entry.

· View the different versions of a software by clicking on the arrow in the first column.

· Select a software and then: 

o Create a New Version  of an approved software, which will automatically flag all

initiatives and places within those initiatives where the selected software is cited or

used.

o Generate a Related Materials Report that lists every initiative and place within each

initiative where the selected software is cited or used.

o Generate an Impact Report that lists every initiative and place within each initiative

where any previous version of the selected software is cited or used.

o View the software information.

o View and then Approve  the software.

o Edit the software information.

o Select Show History  to review the changes made to the software, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the software, if has not been cited in any initiative.

5.6 Tools/Equipment

On the Tools/Equipment screen, you can create and manage the tools and equipment that are

used in initiatives. This includes all tools or equipment that are used during the learning event,

including hand tools, power tools, computers, maintenance trainers, and all other kinds of

training devices. For each tool or piece of equipment, you can:

· Add a new tool or piece of equipment to the existing list by clicking on + New.

· Export a spreadsheet listing all tools and equipment entries with all the details in LEAD for

each entry.
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· View the different versions of a tool or piece of equipment by clicking on the arrow in the

first column.

· Select a tool or piece of equipment and then: 

o Create a New Version  of an approved tool or piece of equipment, which will

automatically flag all initiatives and places within those initiatives where the selected

tool or piece of equipment is cited or used.

o Generate a Related Materials Report that lists every initiative and place within each

initiative where the selected tool or piece of equipment is cited or used.

o Generate an Impact Report that lists every initiative and place within each initiative

where any previous version of the selected tool or piece of equipment is cited or used.

o View the tool or piece of equipment information.

o View and then Approve  the tool or piece of equipment.

o Edit the tool or piece of equipment information.

o Select Show History  to review the changes made to the tool or piece of equipment,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

o Delete the tool or piece of equipment, if has not been cited in any initiative.
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Library

This chapter describes the library items available in LEAD that you can add to and reuse
many times in your initiatives.
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6 Library

On the Library screens, you can set up and manage the following:

· Verbs  - create and manage the verbs that are used the task analysis, whose skills form

the basis for the learning objectives in LEAD.

· Conditions  - create and manage the conditions that are used the task analysis, whose

skills form the basis for the learning objectives in LEAD.

· Standards  - create and manage the standards that are used the task analysis, whose

skills form the basis for the learning objectives in LEAD. 

· Knowledge  - create and manage the knowledge entries that are used in the task

analysis and which can also be used as the basis for learning objectives.

· Skills  - create and manage the skill entries that are used in the task analysis and which

can also be used as the basis for learning objectives.

· Abilities  - create and manage the ability entries that are used in the task analysis and

which can also be used as the basis for learning objectives.

· Interventions  - create and manage the existing interventions that are used to show

which skills are already being taught in existing learning events, particularly those outside

of LEAD. 

6.1 Verbs

On the Verbs screen, you can create and manage the verbs that are used for the skills in the

task analysis in LEAD. For each verb, you can:

· Add a new verb to the existing list by clicking on + New.

· Export a spreadsheet listing all verbs entries with all the details in LEAD for each entry.

· Select a verb and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected verb is cited or used.

o View the verb information.

o View and then Approve the verb.

o Edit the verb information.

o Select Show History  to review the changes made to the verb, including the user

name and date/time of saved changes, and revert to an earlier saved revision.
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o Delete the verb, if has not been cited in the task analysis of any initiative.

6.2 Conditions

On the Conditions screen, you can create and manage the conditions that are used for the

skills in the task analysis in LEAD. For each condition, you can:

· Add a new condition to the existing list by clicking on + New.

· Export a spreadsheet listing all conditions entries with all the details in LEAD for each

entry. Select a condition and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected condition is cited or used.

o View the condition information.

o View and then Approve the condition.

o Edit the condition information.

o Select Show History  to review the changes made to the condition, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the condition, if has not been cited in the task analysis of any initiative.

6.3 Standards

On the Standards screen, you can create and manage the standards that are used for the skills

in the task analysis in LEAD. For each standard, you can:

· Add a new standard to the existing list by clicking on + New.

· Export a spreadsheet listing all standards entries with all the details in LEAD for each entry.

· Select a standard and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected standard is cited or used.

o View the standard information.

o View and then Approve the standard.

o Edit the standard information.
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o Select Show History  to review the changes made to the standard, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the standard, if has not been cited in the task analysis of any initiative.

6.4 Knowledge

On the Knowledge screen, you can create and manage the knowledge entries that are used

for the skills in the task analysis in LEAD. In LEAD, we provide you with the Department of

Labor O*NET Knowledge listing, based on the Department of Labor's (DOL) Standard

Occupational Classification (SOC). These knowledge entries are already approved and used

on the Competencies screens, so they cannot be deleted. For each knowledge entry, you can:

· Add a new knowledge entry to the existing list by clicking on + New.

· Export a spreadsheet listing all knowledge entries with all the details in LEAD for each

entry.

· Select a knowledge entry and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected knowledge entry is cited or used.

o View the knowledge entry.

o View and then Approve the knowledge entry.

o Edit the knowledge entry.

o Select Show History  to review the changes made to the knowledge entry, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the knowledge entry, if has not been cited in the task analysis of any initiative, or

for a competency entry.

6.5 Skills

On the Skills screen, you can create and manage the skill entries that are used for the skills in

the task analysis in LEAD. In LEAD, we provide you with the Department of Labor O*NET Skills

listing, based on the Department of Labor's (DOL) Standard Occupational Classification (SOC).

These skill entries are already approved and used on the Competencies screens, so they

cannot be deleted. For each skill, you can:

· Add a new skill entry to the existing list by clicking on + New.
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· Export a spreadsheet listing all skills entries with all the details in LEAD for each entry.

· Select a skill entry and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected skill is cited or used.

o View the skill entry.

o View and then Approve the skill entry.

o Edit the skill entry.

o Select Show History  to review the changes made to the skill entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the skill entry, if has not been cited in the task analysis of any initiative.

6.6 Abilities

On the Abilities screen, you can create and manage the ability entries that are used for the

skills in the task analysis in LEAD. In LEAD, we provide you with the Department of Labor

O*NET Abilities listing, based on the Department of Labor's (DOL) Standard Occupational

Classification (SOC). These ability entries are already approved and used on the

Competencies screens, so they cannot be deleted. For each ability entry, you can:

· Add a new ability entry to the existing list by clicking on + New.

· Export a spreadsheet listing all abilities entries with all the details in LEAD for each entry.

· Select an ability entry and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected ability is cited or used.

o View the ability entry.

o View and then Approve the ability entry.

o Edit the ability entry.

o Select Show History  to review the changes made to the ability entry, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the ability entry, if has not been cited in the task analysis of any initiative.
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6.7 Interventions

On the Interventions screen, you can create and manage the existing interventions that are

used for the skills in the task analysis in LEAD. For each existing intervention, you can:

· Add a new intervention to the existing list by clicking on + New.

· Export a spreadsheet listing all interventions entries with all the details in LEAD for each

entry.

· Select an intervention and then: 

o Generate a Related Materials report that lists every initiative and place within the

initiatives where the selected intervention is cited or used.

o View the intervention information.

o View and then Approve the intervention.

o Edit the intervention information.

o Select Show History  to review the changes made to the intervention, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the intervention, if has not been cited in the task analysis of any initiative.

100



Reports

This chapter describes how to generate the reports available in LEAD.
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7 Reports

On the Reports screen, you can create outputs from LEAD that are not tied to specific

initiatives. Simply find the report you would like to generate. Select it in the list and select

View. If a report has options, they will show in a pop-up window for you to set as desired. The

following reports are available:

· In the Library group:

o All KSAs - a spreadsheet listing all KSAs that are in the Library, with Knowledge, Skills,

and Abilities each on their own tabs.

o All Conditions/Standards - a spreadsheet listing all Conditions, Standards, and Verbs on

separate tabs.

o All Interventions - a spreadsheet listing all Interventions that are in the Library.

· In the Initiatives group:

o All Initiatives - a PDF document listing all initiatives, grouped by Departments and My

Initiatives, along with the Initiative State, Start and End Date information.

· In the Resources group:

o All Resources - a spreadsheet listing all Resources in LEAD along with their information,

with each Resource category (Consumables, IETMs, IMM, Publications, Software, and

Tools/Equipment) listed on a separate tab.

o Unused Resources - a spreadsheet listing all Resources in LEAD that have not been cited

or linked to in any initiative, with each Resource category (Consumables, IETMs, IMM,

Publications, Software, and Tools/Equipment) listed on a separate tab; this allows users

to identify any resources that are not in use for possible deletion.

· In the Users group:

o User Listing - a spreadsheet listing all Users in LEAD; when you generate the report, you

can choose to select one or more types of users to output:

§ Active Users.

§ Pending Users - those who have requested an account.

§ Inactive Users - those who have not logged in for more than a certain number of

days (set by the system administrators).

§ Locked-Out Users - those who have entered their password incorrectly too many

times.



91

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2022 Aimereon

Reports

§ Deleted Users - those that have been deleted from the system (whose information is

retained only to ensure nothing breaks by having no selection for the initiative owner

for example).
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Admin

This chapter describes the administrative options available in LEAD.
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8 Admin

On the Admin screens, you can set up and manage the following:

· Announcements  - create and manage the announcements that show on the login

screen.

· Departments  - create and manage the departments in LEAD.

· Initiative Locations  - create and manage the learning event initiative locations for use

in initiatives.

· Users  - create and manage the users that have access to LEAD.

· Roles  - create and manage the roles that determine the privileges users have in LEAD.

· System Logs  - review and delete system logs.

· In-Use  - review and reset in-use data. 

· Licensing  - create and manage LEAD licenses.

8.1 Announcements

On the Announcements screen, you can create and manage the announcements that show on

the login screen and on the Announcements screen that you can access by selecting the

Announcement icon that displays between your user name and the help icon in the header

bar. Once you've reviewed the announcements, you can close the pop-up. There are three

types of Announcement icons:

·  - this icon displays when there are active announcements to view.

·  - this icon displays when there are unread/new announcements to view.

·  - this icon displays whenever there is a problem with the license for LEAD.

For each announcement, you can:

· Add a new announcement to the existing list by clicking on the + New.

· Select an announcement and then: 

o View the announcement information.

o Edit the announcement information.

o Select Show History  to review the changes made to the announcement, including

the user name and date/time of saved changes, and revert to an earlier saved revision.
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o Delete the announcement.

8.2 Departments

On the Departments screen, you can create and manage the departments that are used in

LEAD. For each department, you can:

· Add a new department to the existing list by clicking on + New.

· Select a department and then: 

o View the department information.

o Edit the department information.

o Select Show History  to review the changes made to the department, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the department, if has not been cited anywhere (particularly in initiatives).

8.3 Locations

On the Locations screen, you can create and manage the locations that you can select from

when you add the initiative location to the TNA or TMD of the initiatives. For each location,

you can:

· Add a new location to the existing list by clicking on + New.

· Select the location and then: 

o View the location information.

o Edit the location information.

o Select Show History  to review the changes made to the location, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the location, if has not been cited in any initiative.

8.4 Users

On the Users screen, you can create and manage the users in LEAD. Use Filter drop-down to

narrow down the list of users displayed. Depending on the Filter selected, you can perform

100
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different actions  on the users listed. When you select a user on this screen, you can use the

icons in the Actions column to:

· View the user information.

· Edit the user information.

· Select Show History  to review the changes made to the user, including the user name

and date/time of saved changes, and revert to an earlier saved revision.

8.5 Roles

On the Roles screen, you can create and manage the roles that give users their primary

privileges in LEAD. A user is assigned a role on the User  screen. Initiatives have their own

privileges that you can set for each user. For each role, you can:

· Add a new role to the existing list by clicking on + New.

· Select a role and then: 

o View the role information.

o Edit the role information.

o Select Show History  to review the changes made to the role, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the role.

Note: The Customizer role that you can assign on the User screen is a LEAD system role,

which cannot be edited. Likewise, you cannot add privileges for the Customizations screens

on the Roles screen. 

8.6 System Logs

On the System Logs screen, you can review, export, and delete system logs that are

automatically generated when a problem occurs in LEAD. You need the System Logs privilege

assigned to your role to see the System Logs entry under the Admin tab. Whenever you get

an error message in LEAD, that error message, along with the detailed Stack Trace

information, is saved in the system logs. This enables you to forward the full error information

to the LEAD support team to find a resolution. 

On this screen you can:

· Export/generate all system log entries to a spreadsheet for off-line review.

· Delete  system log entries.
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· Select a system log entry and View  the system log information.

8.7 In-Use

On the In-Use screen, you can review and reset in-use data that may be preventing you or

another user from editing something in LEAD. Whenever you open an item in LEAD for edit,

that item is set to be in-use or locked, meaning other users cannot simultaneously edit the

same item. However, there are times when an item is locked when no one is actually editing

the item, i.e., the system hiccupped and didn't unlock the item, when it should have. 

Prior to resetting something that is listed on this screen, we recommend that you first verify

that the user that has locked the item in question is not currently logged into LEAD by going

to the Admin > Users screen (Using the Currently Logged In Users filter), to prevent loss of

data.

Deleting older in-use items typically will not cause any problems.

8.8 Licensing

On the Licensing screen, you can review your existing license for LEAD and add a new license

when needed. For each license, you can:

· Add a new license to the existing list by clicking on + New, entering the License Code

provided by Aimereon, Inc., and selecting Save. 

· Select a license and then: 

o View the license information.

o Select Show History  to review the changes to the license, including the user name

and date/time when it was saved.

o Delete the license.

You can click on the column headers of the table to sort the licenses by that column. Clicking

on a column header again, will reverse the sort. Small arrows in the column header let you

know which way the data is currently sorted.
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9 Common Actions

Some of the things you may do frequently and across multiple areas of LEAD are:

· Reviewing the History  of an item and possibly reverting to an earlier revision/saved

version of that item.

· Resequencing Items  on the screen, including item that are in a tree structure.

· Selecting Resources  for the TNA, TMD, and skills.

· Using the Text Editor . 

· Working with Business Rules .

· Working with Flags .

9.1 Reviewing History

Any time you see Show History, you can review the save history for the selected item. Each

row in the table lists a saved revision of the item, along with the user name that saved the

change, and the date and time the change was saved. Selecting a row will display that saved

revision on the bottom of the screen, so you can review it. Revert allows you to go back to

that saved revision. You will only see Revert, if the item is not approved, and if you have the

privileges to edit the item.

9.2 Resequencing Items

Any time you see Resequencing, you can change the order of the items underneath the

selected item. When you select Resequencing, you see a list of items that you can resequence

(change the order of) simply by clicking and dragging individual items in the order they

should appear.

You can also use the Sort Alphabetically link to automatically sort all entries in alphabetical

order when that link is on the screen.

Once you've sorted everything to your satisfaction, select Save to save the changes. Selecting

Cancel will revert back to the previous order.
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9.3 Selecting Resources  for the TNA, TMD, and Skills

Resources  need to be created on the Resources tab, before they can be selected on the

Resource Selection screen. On that screen: 

· Currently selected resources are listed at the start of the list.

· Use the Type drop-down and the Find field to search for the resources to add. 

· View the different versions of a resource by clicking on the arrow in the first column. 

· Select View to view the resource information.

· Put a checkmark next to the resource(s) you wish to select (or unselect). You can select or

unselect multiple resources and resource types at a time.

· Select OK to save the selected resources, select Cancel to return to the previous screen.

Remember, you still have to save on that screen, selecting OK merely confirms your

resource selection. 

9.4 Using the Text Editor

You can use the icons and drop-downs of the text editor to manage how your content

appears, whether on-screen or in printed materials. Depending on you privilege level to a

certain area you may have three views available to you (buttons on the bottom of the text

area), if you do not see three buttons, then you do not have the privilege level required to

use the HTML or Preview views:

· Design - the default view, with active icons depending on what you have selected.

· HTML - for advanced users that want or need to tweak the output.

· Preview - to preview the end result.

In LEAD, you have the following options available:

Icon Description Shortcut

Applies bold formatting to selected text. Ctrl+B

Applies italic formatting to selected text. Ctrl+I

Applies underline formatting to selected text. Ctrl+U
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Applies strike-through formatting to selected text.

Converts the selected text to upper case, preserving the non-

text elements such as images and tables.

Converts the selected text to lower case, preserving the non-

text elements such as images and tables.

Aligns the selected paragraph to the left.

Aligns the selected paragraph to the center.

Aligns the selected paragraph to the right.

Sets the paragraph style.

Sets the font typeface.

Sets the font size.

Cuts the selected content and copies it to the clipboard. Ctrl+X

Copies the selected content to the clipboard. Ctrl+C

Pastes the copied content from the clipboard into the editor. Ctrl+V

Pastes the copied content from the clipboard into the editor

using one of the following options:

· Paste from Word button - Pastes content copied from

Word and removes the web-unfriendly tags.

· Paste from Word, strip font button - cleans all Word-

specific tags and removes font names and text sizes.

·  Paste Plain Text button - Pastes plain text (no formatting)

into the editor.

·  Paste as HTML button - Pastes HTML code in the content

area and keeps all the HTML tags.

·  Paste HTML button - Pastes HTML content in to the editor.

Indents paragraphs to the right.
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Indents paragraphs to the left.

Creates a bulleted list from the selected text.

Creates a numbered list from the selected text.

If you wish to change the type of list, first create your list,

then select </> HTML below the text editor and change the

<ol> code to:

· <ol type="A"> for capital letters (A, B, C, etc.).

· <ol type="a"> for lower case letters (a, b, c, etc.).

· <ol type="I"> for capital roman numbers (I, II, III, etc.).

· <ol type="i"> for lower case roman numbers (i, ii, iii,

etc.).

Select Design below the text editor to see the results. 

If you wish to stop and start your list, create your lists first,

then select </> HTML below the text editor and change the

<ol> code for the lists you want to continue counting to:

<ol start="X"> where X is the number to start the list with

(in the case of a letter list, use the number represented by the

letter). 

For example, if you want to start the list with 3, then it would

state: <ol start="3">

Note: When you continue numbering, it may be easier to add

the desired starting number in your text until you update the

HTML code. Once you've verified that everything is OK, then

you can delete that number from your text. The number

makes it easier to find the text in the HTML code view. 

Also, the text editor may change some of the HTML code,

after you save it. So it may not look the same, but it should

still work as expected.

Undoes the last action. Selecting the drop-down allows you

to pick how many actions to undo.

Ctrl+Z

Redoes/Repeats the last action, which you just undid.

Selecting the drop-down allows you to pick how many

actions to redo.

Ctrl+Y
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Format Painter allows you to:

· Copy the format of selected text.

· Apply the copied format to other text.

· Clear the format of selected text.

Changes the color of the selected text.

Changes the background color of the selected text.

Opens the Table options:

· Select number of rows and columns and insert a table of

that size.

· Table Wizard  link has more options to configure a table.

· Insert Row Above button - inserts a row above the selected

row.

· Insert Row Below button - inserts a row below the selected

row.

· Delete Row button - deletes the current selected row.

· Insert Column to the Left button - inserts a column to the

left of the selected column.

· Insert Column to the Right button - inserts a column to the

right of the selected column.

· Delete Column button - deletes the current selected

column.

· Merge Cells Horizontally button - merges the selected cell

with the cell to the right.

· Merge Cells Vertically button - merges the selected cell

with the cell below.

· Split Cell Horizontally button - splits the selected cell into

two cells side by side.

· Split Cell Vertically button - splits the selected cell into two

cells one above the other.

· Delete Cell button - deletes the current selected cell.
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· Table Properties button - also opens the Table Wizard

for options to configure the selected table.

Makes a text subscript.

Makes a text superscript.

Inserts the selected symbol.

Prints the contents of the editor using the browser's print

functionality.

Ctrl+P

Selects all the text in the editor. Ctrl+A

Inserts a page break at the cursor, which will force a page

break in the PDF output. 

9.4.1   Table Wizard

The Table Wizard provides advanced features for creating and customizing tables in the

editor's content area. The Table Wizard is a dialog with tabs for detailed table design: Table

Design, Table Properties, Cell Properties, and Accessibility. You can open the Table

Wizard by using the Insert Table Dropdown.

Table Design

This tab allows you to adjust the number of rows and columns as well as adjust the row and

column span. You can also configure table dimensions and layout by setting one or more of

the following table properties:

· Width/Height - Specifies the height and the width of the table (in pixels or percent).

· Cell Spacing - Increases or decreases the space between the borders of the cells.

· Cell Padding - Increases or decreases the space between the content and the border of

a cell.

· Alignment - Aligns the table to the left, center, or right side of the page.

· Back Color - Sets the background color of the table.

· CSS Class - Specifies table CSS class and style. This property should be used only by

advanced users.

· Back Image - Sets an image as the table background.

· More Table Styling - Open the style builder dialog.
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Table Design tab of the Table Wizard

Table Properties

You can select a particular predefined layout for the table and apply special formats to the

heading/last row and first/last column. 
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Table Properties tab of the Table Wizard

Cell Properties

The Cell Properties tab allows you to fine-tune the appearance of individual cells of a given

table. Here you can configure cell width, height, alignment, background, the cell ID, toggle

text wrapping and set the CSS class for a given cell.
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Cell Properties tab of the Table Wizard

Accessibility

The Accessibility tab allows you to adjust the number of heading rows and columns, add

caption settings and a summary, and a checkbox to associate cells with the headers.
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Accessibility tab of the Table Wizard

9.5 Working with Business Rules

When you change the status or lock various items in an initiative, the business rules will run to

check whether anything is missing or incorrect for the item or any of its children. This includes

the following items in LEAD: 

· the initiative itself when editing on the Initiatives > Initiatives screen and the

Analysis/Design > Initiative Management screens.

· the TNA and TMD.

· all skills under the Training Needs Analysis folder.

· all objectives.

· the table of contents items on the Develop tab, e.g., the course and individual modules,

lessons, sections, and assessments.

The business rules will also run when you export or generate a SCORM Package of the

initiative on the Implement tab. You can select which business rules run for which action or

change of status on the Customizations  tab. When an item fails one of more business rules,

the Business Rules Results screen pops-up notifying you of the items that need to be fixed.
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9.6 Working with Flags

LEAD uses various flags to alert you to new versions of resources in you initiatives, as well as

changes to your initiative content, after you have approved the initiative. 



Customizations

A special group of users can customize certain features of LEAD. This chapter details
what can be customized in LEAD.
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10 Customizations

Only designated users with a Customizer role have access to the Customizations screens,

where they can customize your LEAD experience. This includes the following:

· Under Lists :

o Resource Sub-Categories  - to manage the resource sub-categories.

o Proficiency Levels  - to manage the proficiency levels that display in the task analysis

and for the objectives, for each of the three learning domains (cognitive, affective, and

psychomotor).

o Task Analysis Content  - to manage the task analysis content that shows on the

Training Task Analysis sub-tab for the tasks, subtasks, and steps in the task analysis for

any initiative.

o Schedule Event Types  - to manage the events that can be chosen for a schedule in

the Training Management Document on the Design tab of any initiative.

o Before Text  - to manage the options that display before a resource on the Develop

tab of any initiative.

o Intervention Types  - to manage the options that display on the Type drop-down on

the Library > Interventions screen.

o Status of Training - to manage the options that display on the Status of Training

drop-down on the main sub-tab for the tasks, subtasks, and steps in the task analysis

for any initiative.

o Type of Training  - to manage what shows on the screen that opens when you select

the Type of Training link on the main sub-tab for the tasks, subtasks, and steps in the

task analysis for any initiative.

o Test Item Delivery  - to manage what shows on the Test Item Delivery drop-down on

the test item editing screen on the Initiatives > Develop tab.

· Business Rules  - to manage the business rules that apply when you change the Status

of an item.

· Configuration  - to manage admin settings.

· Default Text  - to manage the default text that displays in some initiative documents, as

well as standard system email messages.
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10.1 Lists

On the Customizations > Lists screens, you can customize your LEAD experience. This includes

the following:

· Resource Sub-Categories  - to manage the resource sub-categories.

· Proficiency Levels  - to manage the proficiency levels that display in the task analysis

and for the objectives, for each of the three learning domains (cognitive, affective, and

psychomotor).

· Task Analysis Content  - to manage the task analysis content that shows on the

Training Task Analysis sub-tab for the tasks, subtasks, and steps in the task analysis for

any initiative.

· Schedule Event Types  - to manage the events that can be chosen for a schedule in the

Training Management Document on the Design tab of any initiative.

· Before Text  - to manage the options that display before a resource on the Develop tab

of any initiative.

· Intervention Types  - to manage the options that display on the Type drop-down on the

Library > Interventions screen.

· Status of Training - to manage the options that display on the Status of Training drop-

down on the main sub-tab for the tasks, subtasks, and steps in the task analysis for any

initiative.

· Type of Training  - to manage what shows on the screen that opens when you select

the Type of Training link on the main sub-tab for the tasks, subtasks, and steps in the task

analysis for any initiative.

· Test Item Delivery  - to manage what shows on the Test Item Delivery drop-down on

the test item editing screen on the Initiatives > Develop tab.

10.1.1   Resource Sub-Categories

On the Resource Sub-Categories screens, you can customize what shows on the Type drop-

downs for the resources in LEAD. You can edit entries for the following existing resource

groupings: 

· Consumables

· IETMs (Interactive Electronic Technical Manuals)

· IMM (Instructional Media Materials)
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· Publications

· Software

· Tool/Equipment

LEAD comes with some common resource sub-categories predefined, that you can change

and update as needed. For each of the categories, you can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information. 

o Edit the entry information.  

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.2   Proficiency Levels

On the Proficiency Levels screens, you can customize what shows on the Proficiency Level

drop-down on the Task, Subtask, of Step sub-tab in the task analysis for any initiative, as well

as on the Assessment subtab for enabling and terminal objectives. The proficiency levels are

listed from lowest level to highest level in the drop-down on those screens. You can edit

entries for the following learning domains:

· Cognitive - based on Bloom's revised taxonomy for the cognitive learning domain that

covers mental skills and knowledge.

· Affective - based on Krathwohl's taxonomy (an adaptation of Bloom's taxonomy) for the

affective learning domain that covers emotional growth and feelings.

· Psychomotor - based on Atkinson's adaptation of Dave's taxonomy for the psychomotor

learning domain that covers manual or physical skills.

For each of the learning domains, you can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information. 

o Edit the entry information.  
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o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.3   Task Analysis Content

On the Task Analysis Content screens, you can customize what shows on the drop-downs on

the Task Analysis sub-tab for the tasks, subtask, and steps in the task analysis for any initiative.

You can edit entries for the following existing categories:

· Safety Hazard Severity

· Criticality of Performance

· Task Delay Tolerance

· Frequency of Performance

· Probability of Inadequate Performance

· Difficult of Performance

· Task Learning Difficulty

· Percent Performing

· Percent of Time Spent on Performance

· Immediacy of Performance

These categories are based on the Department of Defense Handbook: Instructional Systems

Development/Systems Approach to Training and Education, MIL-HDBK-29612-2 Chapter

6.8.1. For each of the categories, you can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information. 

o Edit the entry information.  

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.
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10.1.4   Schedule Event Types

On the Schedule Event Types screens, you can customize what shows in the:

· Type drop-downs on the schedule, under the Training Management Document on the

Design tab of any initiative.

· Test Type drop-down for assignments on both the Design and Develop tabs of any

initiative.

You can edit entries for the following schedule event types:

· Class Types - for theoretical and cognitive events, like lectures or discussions.

· Laboratory Types - for skill and psychomotor events, like shop or field work.

· Assessment Types - for all assessment or test events that are graded (non-graded

assessments like quizzes can be created under Theory or Laboratory).

· Other Types - for all other events that you need to account for in your schedule, like

administrative time or lunch.

For each of the schedule event types, you can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information. 

o Edit the entry information. 

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.5   Before Text

On the Before Text screen, you can customize what shows on the Before Text drop-downs

when you cite a resource on the Develop tab of any initiative, in a page or paragraph, on a

sheet, or in a test item. You can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information. 

o Edit the entry information. 
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o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.6   Intervention Types

On the Intervention Types screen, you can customize what shows on the Type drop-down on

the Library > Interventions screen. You can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information.  

o Edit the entry information. 

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.7   Status of Training

On the Status of Training screen, you can customize what shows on the Status of Training

drop-down on the main sub-tab for the tasks, subtasks, and steps in the task analysis for any

initiative. You can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information.

o Edit the entry information. 

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.8   Types of Training

On the Types of Training screen, you can customize what shows on the screen that opens

when you select the Types of Training link on the main sub-tab for the tasks, subtasks, and

steps in the task analysis for any initiative. You can:

· Add a new entry to the existing list by selecting + New. 

100

100

100
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· Select an entry and then: 

o View the entry information. 

o Edit the entry information. 

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.1.9   Test Items Delivery

On the Test Items Delivery screen, you can customize what shows on the Test Item Delivery

drop-down on the test item editing screen on the Initiatives > Develop tab. 

On the Test Items Delivery screen, you can:

· Add a new entry to the existing list by selecting + New. 

· Select an entry and then: 

o View the entry information. 

o Edit the entry information. 

o Select Show History  to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete the entry.

10.2 Business Rules

On the Business Rules screen, you can select which business rules will run for which action(s)

or change(s) in status of various items in an initiative, including:

· the initiative itself when editing on the Initiatives > Initiatives screen and the

Analysis/Design > Initiative Management screens.

· the TNA and TMD.

· all skills under the Training Needs Analysis folder.

· all objectives.

· the table of contents items on the Develop tab, e.g., the course and individual modules,

lessons, sections, and assessments.

For each business rule, you can select an entry and then:

100
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· View the business rule. 

· Edit the business rule.  

10.3 Configuration

On the Configuration screen, you can set up the details for a specific LEAD instance/install.

This includes the settings for the system administrator email address, time limits, and email

server settings, among several others. For each of the configuration entries, you can select an

entry and then:

· View the entry information. 

· Edit the configuration entry. 

· Select Show History  to review the changes made to the configuration entry, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

10.4 Default Text

On the Default Text screen, you can customize the default text that displays for the standard

system email messages, as well as the following:

· Assessment instructions that display when you select the Test Instructions link:

o Proctor Instructions.

o Participant (Student) Instructions.

· Content Type Wizard that displays when you select the Decision Wizard for the Content

Type when editing the enabling objective or the EO Level:

o Content Type - instructions for using the wizard.

o Content Type Wizard Data - including the examples that are used in the wizard.

For each of the default text areas, you can select an entry and then:

· View the default text. 

· Edit the default text. 

· Select Show History  to review the changes made to the default text, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

100
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